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1 Cetting Started

The following sections introduce the CAGE browser part of the Model-Based
Calibration Toolbox.

“About CAGE” on page 1-3
“Starting CAGE” on page 1-5
“How to Use This Manual” on page 1-9

“System Requirements” on page 1-11



About CAGE

About CAGE

CAGE (CAlibration GEneration) is an easy-to-use graphical interface for
calibrating lookup tables for your electronic control unit (ECU).

As engines get more complicated, and models of engine behavior more
intricate, it is increasingly difficult to rely on intuition alone to calibrate lookup
tables. CAGE provides analytical methods for calibrating lookup tables.

CAGE uses models of the engine control subsystems to calibrate lookup tables.
With CAGE you fill and optimize lookup tables in existing ECU software using
models from the Model Browser part of the Model-Based Calibration toolbox.
From these models, CAGE builds steady-state ECU calibrations.

CAGE also compares lookup tables directly to experimental data for validation.

Calibrating Lookup Tables Using CAGE

There are two different types of calibration that you can perform using CAGE:

® Feature calibration
e Tradeoff calibration

Feature Calibration

A feature calibration compares a model of an estimated signal with a lookup
table (or algebraic collection of tables) which estimates the same signal in the
ECU. CAGE finds the optimum calibration for the lookup table(s).

For example, a typical engine subsystem controls the spark angle to produce
the peak torque; that is, the Maximum Brake Torque (MBT) spark. Using the
Model Browser, you can build a statistically sound model of MBT spark, over a
range of engine speeds and relative air charges, or loads. Use the feature
calibration to fill a lookup table by comparing the table to the model.

Tradeoff Calibration

A tradeoff calibration fills lookup tables by comparing models of different
engine characteristics at key operating points.

For example, there are several models of important engine characteristics,
such as torque and Nitrogen Oxides (NOx) emissions. Both models depend on
the spark angle. At a particular operating point, a slight reduction of torque
may result in a dramatic reduction of NOx emissions. Thus, the calibrator uses
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the value of the spark angle that gives this reduction in NOx emissions in favor
of the spark angle that generates maximum torque.

Comparing Calibrations to Data
You can compare your calibrations to experimental data, for validation.

For example, after completing a calibration, you can import experimental data
from a spreadsheet. You can use CAGE to compare your calibration to the data.



Starting CAGE

Starting CAGE
To start the application, type
cage
The view of CAGE depends on two things:

® The process or object type that you are viewing

¢ The item you highlight in the branch display (tree)
When you open CAGE, it looks like this.
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Starting CAGE

CAGE includes a Processes pane and a Data Objects pane to help you identify
the type of calibration you want to do, and the data objects that you intend to
use.

Processes

The Processes pane enables you to select the type of calibration that you want
to perform with CAGE. For example, if you want to calibrate lookup tables by
comparing them to a model, select Feature.

Frocesses

o

Feature

The Processes pane has three buttons:

¢ Feature shows the Feature view, with any tables or strategies that are
associated with that feature.
For more information, see “Feature Calibrations” on page 8-1.

¢ Manual Calibration enables you to calibrate tables manually. It also acts as
a store for all the tables and normalizers in your session.

® Tradeoff shows the Tradeoff view, with a list of the tables and models to
display.

For more information, see “Tradeoff Calibrations” on page 9-1.
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Data Objects

The Data Objects pane lets you identify the different objects that you need to
perform the calibrations with CAGE. For example, if you want to fill lookup
tables by comparing them to models, you need to include models. Select Models
to view the models in your session.

[ata Objects

The Data Objects pane has these buttons:

® Variable Dictionary stores all the variables, constants and formulas in your
session. Click Variable Dictionary to view and edit any variables in any
part of your session.

For more information, see “Setting Up Your Variable Items” on page 6-7.

® Models stores all of the models in your session. Click Models to show a
graphical display of the models in your session.

For more information, see “Setting Up Your Models” on page 6-14.

® Data Sets enables you to see the data produced by your objects, and enables
you to compare this with other data such as experimental data.

For more information, see “Data Sets” on page 10-1.

For a more detailed overview of CAGE functionality in different views and
links to in-depth help on each topic, see “Using CAGE” on page 6-1.



How to Use This Manual

How to Use This Manual

This manual is the CAGE User’s Guide. See also the Model Browser User’s
Guide for information on the other main interface of the Model-Based
Calibration Toolbox.

Learning CAGE
There are four tutorial chapters, with worked examples to guide you through
using the tools in CAGE:

¢ “Feature Calibration Tutorial” on page 2-1 describes how to set up and
calibrate lookup tables by reference to a model.

¢ “Tradeoff Calibration Tutorial” on page 3-1 describes how to calibrate lookup
tables using tradeoff calibrations.

¢ “Data Sets Tutorial” on page 4-1 describes how to validate calibrations using
experimental data.

¢ “Filling Tables from Data Tutorial” on page 5-1 describes how to fill lookup
tables using experimental data.

Using CAGE

¢ “Using CAGE” on page 6-1 describes how to set up CAGE sessions before
performing calibrations and gives an overview of where in CAGE to find all
the functionality for different processes.

® “Normalizers” on page 7-1 describes what normalizers are, and how to space
breakpoints in a normalizer.

¢ “Feature Calibrations” on page 8-1 describes how to calibrate lookup tables
by reference to models built using the model browser.

® “Tradeoff Calibrations” on page 9-1 describes how to calibrate lookup tables
by adjusting one value to fulfill different objectives.

® “Data Sets” on page 10-1 describes how to use CAGE to compare calibrations
to experimental data, and how to use experimental data to fill lookup tables.

e “Calibration Manager” on page 11-1 describes how to use the Calibration
Manager.

® “Surface Viewer” on page 12-1 describes how to use the Surface Viewer.
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¢ “Manual Calibration and the History Display” on page 13-1 describes how to
use the History viewer, and how to add and delete tables and manually
calibrate tables.

Training Material

The files for the tutorial chapters are all contained in the matlab/toolbox/
mbc/mbctraining directory.
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System Requirements

System Requirements

This section lists the following:

¢ Hardware requirements

¢ Operating system requirements
¢ Required MathWorks products
¢ Optional MathWorks products

Hardware Requirements

The Model-Based Calibration Toolbox has been tested on the following
processors:

¢ Pentium, Pentium Pro, Pentium II, Pentium III, and Pentium IV
e AMD Athlon

Minimum memory:
e 256 MB
Minimum disk space:

® 450 MB for the software and the documentation

Operating System Requirements
The Model-Based Calibration Toolbox is a PC-Windows only product.

The product has been tested on
Microsoft Windows NT, 2000, and 98.
You can see the system requirements for MATLAB online at

http://www.mathworks.com/products/system.shtml/Windows
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Required MathWorks Products

Model-Based Calibration requires the following other MathWorks products:
e Simulink®

¢ Optimization Toolbox

¢ Statistics Toolbox

¢ Extended Symbolic Math Toolbox

Optional MathWorks Products

The Model-Based Calibration Toolbox can use the following MathWorks
product:

¢ Neural Network Toolbox
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This section describes what a feature calibration is, and illustrates the various
processes required to perform a feature calibration.

¢ “What Are Feature Calibrations?” on page 2-3 describes what a feature
calibration is.

¢ “Setting Up Calibrations” on page 2-4 describes the processes required to set
up calibrations in CAGE.

¢ “Creating a Feature Calibration” on page 2-11 describes the various parts of
the feature calibration, and how to incorporate them into a calibration in
CAGE.

e “Calibrating a Feature” on page 2-17 describes the processes of calibrating
the various aspects of a feature.

¢ “Exporting Calibrations” on page 2-26 describes how to export the
calibration when it is completed.



What Are Feature Calibrations@

What Are Feature Calibrations?

The feature calibration process within the Model-Based Calibration Toolbox
calibrates an estimator, or feature, for a control subsystem in an electronic
control unit (ECU). These features are usually algebraic collections of one or
more tables. You use the features to estimate signals in the engine that are
unmeasurable, or expensive to measure, and are important for engine control.
The toolbox can calibrate the ECU subsystem by directly comparing it with a
plant model of the same feature.

An example of an ECU subsytem control feature estimates the value of torque,
depending on the four inputs: speed, load, air-fuel ratio (AFR), and spark angle.

A diagram of this ECU subsystem example follows.

Plant Model for Torque = TQ(speed, load, AFR, spark)

| I
+

s vl |
lood |
air-fuel I +
ratio I : I

| I
spark I + |
angle [ : |

L (== — — a

ECU SUBSYSTEM

In this example, there are three lookup tables:

® A speed-load table
* A modifier, or table, for AFR
* A modifier for spark angle

This tutorial takes you through the various steps required to set up this feature
and then calibrate it using CAGE.
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Setting Up Calibrations

Start CAGE by typing
cage

at the MATLAB prompt.

Note If you have a CAGE session open, select File -> New —> Project.

Before you can perform a calibration, you must set up the variable dictionary
and models that you want to use.

Setting Up Variables

To set up the variables and constants that you want to use in your calibration:

1 Click Variable Dictionary in the Data Objects pane of CAGE

The Variable Dictionary displays all the variables, constants, and formulas in
a session.

There are two ways in which you can set up variables:

¢ Import a variable dictionary

¢ Add variables and constants to your session

After setting up your variables and constants, you can export the variable
dictionary to use in other calibrations.

Importing a Variable Dictionary
To import a variable dictionary:

1 Select File —> Import —> Variable Dictionary.



Sefting Up Calibrations

2 Select the tutorial.xml file found in matlab\toolbox\mbc\mbctraining
and click Open.

This imports a set of variables and a constant. In our example, the variable
dictionary contains

® N, engine speed
e | load
e A, AFR

® The stoichiometric constant, stoich

Your display should resemble the following.

2-5
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‘} CAGE Browser - Untitled o ] |
File Edit Variable Tools ‘Window Help

D@ | X #Fa |BRDE

Processes Wariable Dictionary

Hame | Tupe | Aliaz | Minimuml Mar:imuml Set F'Dintl Formula
x M “ariable  engine_speed R00 E500 2500
xL Yariable  load, Load 01 1 0.4
X A Yariable  afr, AFF 11 17 14.35
k stoich Constant 1435

[

L

I i N
Aliaz: I engine_speed
Drezcription; I Engine zpeed [rpm)

Minimurn: [ 500 2| Masimur: [ £500 2|
Set Poirt: [ 2500 5|

Farmula: I

Adding and Editing Variables and Constants

To add a variable for the spark angle:

1 Click in the toolbar. This adds a new variable to your dictionary.
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2 Select Edit -=> Rename to rename the variable.
3 Enter SPK as the name.

4 Set the range of the variable by entering -5 as the Minimum and 50 as the
Maximum.

The variable dictionary enables you to specify different names for the same
variable, and also give descriptions of variables. For example, the variable spk
might be referred to as S or spark in other models.

To ensure that CAGE recognizes an instance of S or spark as the same as spk,
specify the aliases of SPK:

5 Enter S, spark in the Alias edit box.

6 Enter Spark advance (deg) in the Description edit box.

Note The Variable Dictionary is case sensitive: s and S are different.

The variable dictionary enables you to specify a preferred value for a variable.
For example, in the preferred value of the variable, AFR is set as the
stoichiometric constant 14.35.

7 Enter 25 in the Set Point edit box to specify the preferred value for spk.

For more information about the variables, see “Setting Up Your Variable
Items” on page 6-7.

Setting Up Models

A model in the Model-Based Calibration Toolbox is a function of a set of
variables. Typically, you construct a model using the Model Browser; then you
can use CAGE to calibrate lookup tables by reference to the model.

The following example uses a model of how torque behaves with varying spark
angle, air-fuel ratio, engine speed, and load.

2-7
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Importing a Model
To import a model built using the Model Browser:

1 Select File —> Import —> Model, which starts the Model Import Wizard.

<} Model Import Wizard - i 10l =l

Filenarne: I D:AMATLABRT 2pT stoolboxtmbembetrainingtutarial. exm J
Open as: I.t’-‘-.utomatic j

Cahicel | < Back | Mext » | Eirizt |

2 Click .| to browse for the correct model file.

3 Select the tutorial.exm file, found in matlab\toolbox\mbc\mbctraining
(this is a copy of the torque model built in the Model Browser’s quick start
tutorial) and click Open.

4 To accept the default setting, leave Open as: Automatic and click Next.

5 There are two models stored in this file, tq and knot. Highlight tq and click
Next to show the following.
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The model factors Variables in the Variable Dictionary

=lof x|

ndel Import Wizard

Model Factors: Available inputs:

| Azzigned Input |

Symbal

& &

L L T

M

zpark, SPE.
[~ Copy range LI

Factor range: | 1091 14,65 Input range: 500 B500
Cancel | < Back | = | Finigh |

Variables in the Variable Dictionary assigned to the model factors
CAGE automatically assigns variables in the variable dictionary to the
model input factors or their aliases (as long as names are exact).

6 Click Finish to complete the wizard.
When you complete the wizard, you return to the Models view.
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) CAGE Browser - Untitled -10] =]
File Edit Model Tools ‘Window Help
DEE|X F&
Processes hodelz |
Hame | Tupe | Inputs | D escription
g MBC modsl spk. ML A
[
LU « | i
Gaia Connections Ig |
=

[rata Objects

o E

W

g0
G0
40
20

x-axis factor:

G000

o 4000

0z 2000
L M

y-axis factor:

[N

= =

For more information about models, see “Setting Up Your Models” on
page 6-14.
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Creating a Feature Calibration

The feature calibration process calibrates an algebraic collection of lookup
tables, or strategy, by comparing the tables to the model.

When you have set up the variables and models, you can set up the feature:

Select File -> New —> Feature.
This automatically displays the Feature pane and creates a new feature.

Click Select Model. This automatically selects tq, the torque model, for you
(because there is currently only one model in your project).

You can see the model appear above the Select Model button.

Create a strategy. For more information, see the next section, “Setting Up
the Strategy” on page 2-13.

A strategy is a collection of tables. The Model-Based Calibration Toolbox
uses Simulink® to enable you to graphically specify the collection of tables
for a feature.

Set up your tables. For more information, see the following section, “Setting
Up the Tables” on page 2-14.
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3. Set up your strategy 4. Initialize the tables  Model pane Strategy pane 2. Assign a model
)} CAGE Browser - Untitled 101 x|
1. Add a Feature ————File Edit “iew Featute Took ‘Wwindow Help
DS E|X|Fa = o
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— Feature History
Comment & Action Add

Hemowve |

Set up the variables

Set up the model
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2-12



Creating a Feature Calibration

Setting Up the Strategy
The toolbox uses Simulink to graphically specify the strategy.

Importing a Strategy
To import a strategy:

1 Select File —> Import —> Strategy.

2 Select the file called tutorial.mdl, found in
matlab\toolbox\mbc\mbctraining and click Open.

3 This opens the Import Strategy dialog box. To view the strategy, click
Manual.

This opens the following Simulink window.

=10l x|

File Edit View Simulation Format Tools  Help

kodel Browser @ﬁﬂ

...... = tutoial r+

« Horm_M
= 1 |

Lf ;v-. i -2z )
ol T L

i Marm_L

Torque_Output

e He——
A

F_A Morm_#A
P e )
| | SPK

F_SPk Norm_SPi

This shows how the strategy is built up.

4 Now double-click the blue circle labeled Torque _Output.

Note This shuts down the Simulink window and parses the new feature into
the calibration browser.
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The New_Feature is the output of the algebraic equation of tables. You can see
this parsed into the Strategy pane.

For a more detailed description of the strategies, see “Setting Up Your
Strategy” on page 8-6.

Setting Up the Tables

Currently, the lookup tables have neither rows nor columns, so you must set
up the tables.

Click £ or select Tools -> Calibration Manager. The Calibration Manager
dialog box opens, so you can specify the number of breakpoints for each axis.



Creating a Feature Calibration

<) Calibration Manager x|
DS @’ o
Calibratable Blocks |I:Dntents of Cal File
/4 Branch 1 Cal | Size |
< ........... |
S At - |
: L,.. Morm_SPE
-] F_SPK
— Manual Setup Cal file:
[ata
R Col I Y al |
10 Rows 12  Columns 0 Walue SetUp o
Frecizion: IEEE Double Precision Edit Precision... | IE‘?l'
nfo:
— Dizplay
Block: T
0.000 1.000 2.000 3.000 4.000 5.000 5.000 7.001
0.000 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.000 =
1.000 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.001
2.000 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.00(
3.000 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.001
4.000 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.00(
5.000 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.001
5.000 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.0on 0.001(
7.000 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.0o0 0.000 -
1 | 3
Cloze |
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To set up table T:
1 Highlight the table T by clicking T in the tree hierarchy.

2 Enter 10 as the number of rows and 12 as the number of columns. This
determines the size of each normalizer.

3 Set the value in each cell to be 0.
4 Click Set Up to change the Display pane to show the table is set up.

5 Follow the same procedure for the F_A table. In other words,
a Highlight the F_A node.
b Set the number of rows to be 10.
¢ Set the value in each cell to be 0.

d Click Set Up.

6 Repeat step 5 for F_SPK.

Note The icons change as you initialize each table or function.

7 Click Close to leave the Calibration Manager.

After completing these steps, you can calibrate the lookup tables.

2-16



Calibrating a Feature

Calibrating a Feature

The feature contains both a strategy (which is a collection of tables), and a
model. You can use CAGE to fill the lookup tables using the model as a
reference.

These are the three steps to calibrate a feature:
1 Calibrate the normalizers.

2 Calibrate the tables.

3 Calibrate the feature as a whole.

These steps are described in the next sections.

Click the expand icon, &, to expand the nodes and display all the tables and
normalizers in the feature.

Feature |

# Branch 1
3. Calibrate the feature 75—23_ Mew_Feature

) i 2. Calibrate the tables
1. Calibrate the normalizers

T/ Mom_SPE

Each node in the display has a different view and different operations.

Calibrating the Normalizers

Normalizers are the axes for the lookup tables. Currently, Norm_N has 12
breakpoints; the other normalizers have 10 breakpoints each. This section
describes how to set values for the normalizers Norm_N and Norm_L, based on
the torque model, tq.

To display the Normalizer view, select the normalizer Norm_N in the branch
display.
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Input output display

Normalizer display Breakpoint spacing display
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4.00

5.00

£.00

7.00

8.00

9.00

W00 = O N | LD D =

Breakpoirt Spacing

The Normalizer view has two panes: Norm_N and Norm_L.

In each pane, you see

¢ An input/output table

¢ A normalizer display

® A breakpoint spacing display
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Calibrating a Feature

In both Normalizer panes, the Input Output table and the Normalizer
Display show the position of the breakpoints.

The Breakpoint Spacing display shows a blue slice through the model with
the break points overlaid as red lines.

For a more detailed description of the Normalizer view, see “Normalizer View”

on page 7-14.

Placing the Breakpoints Automatically

You now must space the breakpoints across the range of each variable. For
example, Norm_N takes values from 500 to 6500, the range of the engine speed.

To space the breakpoints evenly throughout the data values:
1 Click [l in the toolbar. Alternatively, select Normalizer —> Initialize.
This opens a dialog box that suggests ranges for Norm_N and Norm_L.

2 To accept the default ranges of values of the data, click OK.

A better fit between model and table can often be achieved by spacing the
breakpoints nonlinearly.

1 Click £ in the toolbar. Alternatively, select Normalizer —> Fill.

This opens a dialog box that suggests ranges for Norm_N and Norm_L. It also
suggests values for AFR and SPK; these values are the set points for AFR and
SPK.

2 To accept the values in the dialog box, click OK.

This ensures that the majority of the breakpoints are where the model is
most curved. The table now has most values where the model changes most.
So, with the same number of breakpoints, the table is a better match to the
model.

For more information about calibrating the normalizers, see “Normalizers”
on page 7-1.

You can now calibrate the lookup tables; this is described in the next section.
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Calibrating the Tables

The lookup tables currently have zero as the entry for each cell. This section
demonstrates how to fill the table T with values of torque using the torque

model, tq.

To view the Table display, click the T node.

2-20

Lookup table Graph of table
A00.00 1054 60 1609.20 z
0.10 0.000 0.000 0.000 0.0
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0.83 0.000 0.000 0.000 0.0
0.89 0.000 0.000 0.000 0.0
0.95 0.000 0.000 0.000 0.0
1.00 0.000 0.000 0.000 0.0
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T able Variables = Mawimum error:
98.87
M: Mir:| 500 Max:| 6500 F'ts:|2EI M
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1.155e+008
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L 200p
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Calibrating a Feature

This view has three panes: the table, the graph, and the comparison-of-results
pane.

To fill the table with values of the model at the appropriate operating points:
1 Click £ on the toolbar.

This opens a dialog box that suggests the set points of AFR and SPK as
appropriate values for evaluating the model over the range of N and L.

2 Click OK.

The following view shows the table filled with values of the model.

500.00 1054.60 1608.20
010 -3.837 -3.190 -2.865
0.15 2.495 3117 3.380
0.25 12.898 13.673 14.047
0.39 28.748 29.743 30.358
0.55 45.642 40.061 51.010
0.73 G4.542 66.105 67.180
0.83 TH.343 77.842 78.843
0.29 24.193 85.556 26.416
0.95 90.974 921451 92.823
1.00 97.626 98.548 98.903

T — 2
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2-22

The following comparison-of-results pane shows just how good a fit the strategy
is to the model.

T able Variables = ’ : Mo
3 S 0.3238
M Minc| 500 Maw:| 6500 F'ts:l 20 Menn it e
L Firc| 0.1 fdaw:| 1 F'ts:l 20 001156
Model Variables Total zquare erar:
4625

A | 14.35
SPE: |25—

The model is represented by the multicolored surface and the strategy is the
blue surface.

The table T is now filled with values of the model at these operating points.

For more information about the process of filling tables, see “Calibrating the
Tables” on page 8-12.

Now you must fill the tables F_A and F_SPK and their normalizers. The tables
are modifiers for AFR and the spark angle respectively. These steps are
described in the next section.

Calibrating the Feature

A feature is a strategy (which is a collection of tables) and a model. Currently
the torque table, T, is filled with values of the torque model, tq. You must now
calibrate the normalizers and tables for F_A and F_SPK.

You could calibrate the normalizers and then the tables for F_ A and F_SPK in
turn. However, CAGE enables you to calibrate the entire feature in one
procedure.

To view the Feature view following, click the New_Feature node.



Calibrating a Feature

:} CAGE Browser - Untitled : o ] [
File Edit Wiew Feature Tools ‘Window Help

D@ X |ffé | EEo

Froceszes Feature | Strateqw: Inputs: M, L, & SPK
«| |4 Branchi
=-¥3 Mew Feature [TIMorm_MNIMLMorm_LILT) + F_A[Marm_a[a]] +

EHQ T F_SPE[Mom_SPKISPE])]

; ..... H Marm W
[ H Marm L

E = F_a

[ H Mam A

= F_SPK.
[ i'_"{ Marm_SPE

tadel: g, Inputst W, L, A, SPE
Select Maodel... | Deselect Maodel |

— Feature Histary

Comment / fetion | D= Add
Strateqy equation diagram created and parsed  16-

D ata Objects Remove |

l | i

Details:

To calibrate all the tables and their normalizers:
1 Select Feature —> Fill to open a dialog box.

2 Confirm the variable ranges and the table-filling order by clicking OK in the
Feature Filling Options dialog box.
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All three tables and normalizers are filled.

As the model and the feature are four-dimensional objects, it is difficult to fully

view a comparison between the feature and the model. A meaningful

comparison is shown in the lower half of the following figure (select the F_A
node in the branch display). The equation model = strategy is rearranged so
that the table is compared to the model and the remainder of the strategy.

Input Output
11.000 -0.2098
11.8904 0.260
12.748 0.487
13.606 0.4049
14.394 0.026
15.061 -0.a77
15.606 -1.373
16.091 -2.397
16.515 -3.580
17.000 -5.352

This display shows that the range of the normalizer for F_Ais 11 to 17, the
range of AFR. The lower pane shows a comparison between the red strategy

Table Variables
A Mir:| 11 F'ls:l 20
Model Variables

M: | 2500

L | 0.4

SPE: I o5

bas:) 17

29

28

27

and a slice through the model, over the range of AFR.
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Calibrating a Feature

You can use CAGE to improve on these results. CAGE can run an optimization
routine over the feature to minimize the total square error between the model
and the feature.

To optimize the feature:
1 Select the New_Feature node
2 Click ﬂ This opens a dialog box, suggesting ranges for the variables.

3 To confirm the default variable ranges and table-filling order, click OK in
the dialog box.

This reduces the error between the feature and the model.

To view this reduction in error, select the F_A node in the branch display.

Notice that the mean square error between the model and the feature over this
range of values is 0.001348, which is less than the 0.002097 previously
obtained.

This completes the calibration of the torque feature.

For more information about calibrating features, see “Calibrating the Feature
Node” on page 8-38.

You now need to export the calibration for the ECU.
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Exporting Calibrations
To export your feature:
1 Select the New Feature node in the branch display.
2 Select File —> Export —> Calibration.

3 Choose the type of file you want to save your calibrations as. You can choose
from

= Comma Separated Value (.csv)
= MAT-file (.mat)
= M-file script

4 For the purposes of this tutorial, select Comma Separated Value (.csv).

5 Enter tutorial.csv as the file name and click Save.

This exports the successful calibration, ready for the ECU.
Note that what you export depends on which node is highlighted:

¢ Selecting a normalizer node outputs the values of the normalizer.
® Selecting a table node outputs the values of the table and its normalizers.
¢ Selecting a feature outputs the whole feature (all tables and normalizers).

¢ Selecting a branch node outputs all the features under the branch.

You have now completed the feature calibration tutorial.

2-26



Tradeoff Calibration

Tutorial

What Is a Tradeoff Calibration?

Creating a Tradeoff Calibration .
Adding Tables to a Tradeoff Calibration
Displaying the Models

Performing the Tradeoff Calibration .

Calibrating the Normalizers .
Setting Values for Other Variables
Filling Key Operating Points .
Filling the Table by Extrapolation .

Exporting Calibrations .

3-3
3-4
3-6
3-7

3-8

.3-10
. 3-12
. 3-13
. 3-16

. 3-18




3 Tradeoff Calibration Tutorial

3-2

This tutorial describes what a tradeoff calibration is and illustrates the various
processes required to perform a tradeoff calibration.

¢ “What Is a Tradeoff Calibration?” on page 3-3 describes what a tradeoff
calibration is.

¢ “Creating a Tradeoff Calibration” on page 3-4 describes the processes
required to set up a tradeoff calibration.

¢ “Performing the Tradeoff Calibration” on page 3-8 describes the processes of
calibrating the various parts of a tradeoff.

¢ “Exporting Calibrations” on page 3-18 describes how to export the
calibration when it is completed.



What Is a Tradeoff Calibration?

What Is a Tradeoff Calibration?

A tradeoff calibration is the process of filling lookup tables by balancing
different objectives.

Typically there are many different and conflicting objectives. For example, a
calibrator might want to maximize torque while restricting nitrogen oxides
(NOx) emissions. It is not possible to achieve maximum torque and minimum
NOx together, but it is possible to trade off a slight reduction in torque for a
reduction of NOx emissions. Thus, a calibrator chooses the values of the input
variables that produce this slight loss in torque over the values that produce
the maximum value of torque.

This tutorial takes you through the various steps required for you to set up this
tradeoff, and then to calibrate the lookup table for it.
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Creating a Tradeoff Calibration

Start CAGE by typing
cage
at the MATLAB prompt.

Before you can calibrate the lookup tables, you must set up the calibration.

1 Select File —> Open Project (or the toolbar button) to choose the
tradeoffInit.cag file, found in the matlab\toolbox\mbc\mbctraining
directory, then click OK.

The tradeoffInit.cag project contains two models and all the variables
necessary for this tutorial. For information about how to set up models and
variables, see “Using CAGE” on page 6-1.

To create a tradeoff calibration:
2 Select File —-> New —> Tradeoff.

This takes you to the Tradeoff view. You need to add tables and display
models to the tradeoff, which are described step by step in the following
sections:

= “Adding Tables to a Tradeoff Calibration” on page 3-6.

= “Displaying the Models” on page 3-7 describes how you display the models
of torque and NOx emissions.



Creating a Tradeoff Calibration

2. Add a new
tradeoff.

1. Open the
project file.

3. Add tables.

-} CAGE Browser - tradeoffInit.cay

—File Edit Tradeoff Tools

‘Window| Help

DEE| x|

&

B

Tradeoff | T

ables

~

Branch 1
88 Mew_Tradsoft

Mo tables in trade-off

Dizplay Options

Available modelz

TG Model 5
MOXFLOW b

Current display:

4. Display the models.
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3-6

Adding Tables to a Tradeoff Calibration

The models of torque and NOx are in the current session. You must add the
lookup table to calibrate.

Both models have five inputs. The inputs for the torque and NOx models are

¢ Exhaust gas recycling (EGR)
¢ Air-fuel ratio (AFR)

e Spark angle

® Speed

¢ Load

For this tutorial, you are interested in the spark angle over the range of speed
and load.

To generate a lookup table for the spark angle:

1 Click @ This opens the Add Table to Tradeoff dialog.

<} Add Table to Tradeoff x|

) Add eisting table

%' Create a new table

Table name: I Spark.

Mormalizers

# name: I Speed Size I 13 Fed with: IN VI
Y hame: I Load Size: I 10 Fed with: IL vI

Fill this table with: | 5P =]

Ok | Cancel Help

2 Enter Spark as the Table Name.

3 Enter Speed as the X Name and Load as the Y name.



Creating a Tradeoff Calibration

4 Enter 13 as the size of the speed axis.

5 Enter 10 as the size of the load axis.

6 Fill the Speed axis with N and the Load axis with L.
7 Fill the table with SPK (spark angle).

8 Click OK.

Before you can perform the calibration, you must display the models.

Displaying the Models

For this tutorial, you are comparing values of the torque and NOx models.
Thus, you need to display these models.

To display both models:
1 Highlight TQ_Model and click > |to include the model in the current display.

2 Repeat for NOXFLOW_Model.

The Display Options pane following shows both models selected for display.

Dizplay Options |

Ayailable models: Current display:

;l TG Modell SPE, LW, A E]
NOXFLOW _Modell SPK, L N, &, E)

& =]

You can now calibrate the tradeoff.
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Performing the Tradeoff Calibration

You now fill the lookup table for spark angle by trading off gain in torque for
reduction in NOx emissions.

The method that you use to fill the lookup table is

¢ Obtain the maximum possible torque.

® Restrict NOx to below 250 g/hr at any operating point.

To perform the tradeoff calibration, follow the instructions in the next four
sections:

1 Calibrate the normalizers.
2 Set values for the other variables.
3 Fill key operating points with values for spark angle.

4 Fill the table by extrapolation.

Once you have completed the calibration, you can export the calibration for use
in the electronic control unit.



Performing the Tradeoff Calibration

4. Fill the table by extrapolation

5. Export the
calibration

3. Fill key operating points in the spark table

) CAGE Browser - tradeoffInit.cag B ] A |
File Edit W%ew Table Tools ‘Window Help
Ded| X |2 +mBE
Processes Tradeoft | Spark: N =500, L =|0.1. Cell filled with SPK. |
- B'a%M 00000 | fo
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i:i Speed 0200
H Load 0.300
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R i B
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= Tl o4 -
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3-10

Calibrating the Normalizers

A normalizer is the axis of the lookup table (which is the collection of
breakpoints). This section describes how to space the breakpoints over the
ranges of speed and load.

Expand the tree by clicking in the branch display so you can see the
normalizers Speed and Load. Highlight either normalizer by clicking to see the
normalizer view.

Speed |

Input Qutput Marmalizer Display Breakpaint Spacing
0.00 0 : : : '
1.00
2.00
3.00
4.00
5.00
6.00
7.00
8.00
9.00
10.00
11.00
12.00

00 ==d | O[O e OO R

[Lu}

-
=

-
—_

-
[gn]

Load

Input Cutput Breakpoint Spacing
0.00 1]
1.00
2.00
3.00
4.00
5.00
6.00
7.00
8.00
9.00

COf00 =] O[O e OO R

A tradeoff calibration does not compare the model and the table directly, so you
cannot space the breakpoints by reference to the model.



Performing the Tradeoff Calibration

e Click [lll to space the breakpoints evenly over the ranges of speed and load.

¢ To accept the default ranges of the variables, click OK in the Breakpoint
Initialization Options dialog box.
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1. Highlight the
Spark node

2. Enter 14.3 05
the value for A

3. Enter 0 as the
value for E

3-12

Setting Values for Other Variables

At each operating point, you must fill the values of the spark table. Both of the
models depend on spark, AFR (labeled A, in the session), and EGR (labeled E in

the session). So you must set values for AFR and EGR for the models.

To set constant values of AFR and EGR for all operating points:

1 Highlight the Spark node in the branch display.

2 In the lower pane, check the value for A is 14. 3, the stoichiometric constant.

3 Enter 0 as the value for E.

A Branch 1
=28 Mew_Tradeoff

——E'tf Spark

bl Spesd

Tradeoff ‘ Spark

N =500 L=0.1.Cellfilled with SPK.

0.100
0.200

500.000

1000.001

0.300

0.400

0.500

0.600

0.700

0 14.3 |/ 0
:!LI_'_F-:L-:_):;’" 10-—'_‘?:___ __\E.\?_ 2 -.;,-_'-_é-;—_—_—J:-’-
T Oy LA ! P
2 fK\z\ IR R T e
Sl i IR S St /A N
ST W RN R R B
= T 1) N
I -30 | . : ‘
o 20 40 12 14 16 ] 5 10
— 2000 T T T T T
] HE b NG K ) TS S
E B ! /:\\: g A
z oo "'?"?"f 1F--4 \'\ 1 \\
5 -—-{: 2 f\ \-:}_:_.:
[T ' - i '
z B Of-r=-af--r-= /| A et
Z 1000 b-q---bond-- e Vo
o 20 40 12 14 16 ] 5 10
SPH A E

5. 4899

0.72677

You can now fill the spark angle lookup table. The process is described next.



Performing the Tradeoff Calibration

Filling Key Operating Points
You now fill the key operating points in the lookup table for spark angle.

The upper pane displays the lookup table, and the lower pane displays the
behavior of the torque and NOx emissions models with each variable.

You maximize the torque and restrict NOx emissions to below 250 g/hr.

To fill an operating point:
1 Select the operating point N = 4500 and L = 0.5 in the lookup table.

2 Find the spark angle that gives the maximum torque and restricts NOx
emissions to below 250 g/hr. There are detailed instructions on how to do
this tradeoff following.
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3-14

Determining the Value of Spark

At each operating point, the behavior of the model alters. The following display
shows the behavior of the models over the range of the input variables.

Graphs of the Models When N = 4500 and L = 0.5

Value of the torque model

N

23.1449

T _Model

% 100 : : 58 5002
4000 f--- | H . _—

| 5000 }---
2000 |- --

1000 f---

MORFLOWY hodel

Value of the NOx model

The top three graphs show how the torque model varies with the spark angle,
the AFR (labeled A), and the EGR (E), respectively. The lower panes show how
the NOx emissions model varies with these variables, respectively.

Looking at the Spark table, the two spark (SPK) graphs are green, indicating
that these graphs are directly linked to the lookup table.

You can change the value of spark by dragging the red line on the SPK graphs
or typing values into the edit box. The following graph shows the behavior of
the two models when the spark angle is 26.4458.



Performing the Tradeoff Calibration

I 26.4485

Torque model
behavior

T _Model

99% Confidence interval
for the torque model

MZHFLOWY i odel

1000

3 Select Find Global Maximum from the right-click menu of the SPK -
TQ_Model graph. This calculates the value of spark that gives the
maximum value of torque.

At this operating point, the maximum torque that is generated is 48.136 when
the spark angle is 26.4485. However, the value of NOx is 347.7861, which is
greater than the restriction of 250 g/hr. Clearly you have to look at another
value of spark angle.

4 Enter 21.5 as the value of SPK in the edit box at the top of the SPK column.

The value of the NOx emissions model is now 249.1542. This is within the
restriction, and the value of torque is 47.2478.

At this operating point, this value of 21.5 degrees is acceptable for the spark
angle lookup table, so you want to apply this point to your table.

5 Press Ctrl+T or click ﬂ (Add Point) in the toolbar to apply that value to the
spark table.
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3-16

This automatically adds the selected value of spark to the table and turns
this cell yellow. It is pink when selected, yellow if you click elsewhere.

6 Now repeat this process of finding acceptable values of spark at four more
operating points listed in the table following. In each case,
= Select the cell in the spark table at the specified values of speed and load.
= Enter the value of spark given in the table (the spark angles listed all
satisfy the requirements).

= Press Ctrl+T or click ﬂ (Add Point) in the toolbar to apply that value to
the spark table.

Speed, N Load, L Spark Angle, SPK
2500 0.3 25.75

3000 0.8 10.7

5000 0.7 8.3

6000 0.2 41.3

After you enter these key operating points, you can fill the table by
extrapolation. This is described in the next section.

Filling the Table by Extrapolation

When you have calibrated several key operating points, you can produce a
smooth extrapolation of these values across the whole table.

When you apply the value of the spark angle to the lookup table, the selected
cell is automatically added to the extrapolation mask. This is why the cell is
colored yellow. The extrapolation mask is the set of cells that are used as the
basis for filling the table by extrapolation.

Click ® to fill the table by extrapolation.
The lookup table is filled with values of spark angle.

The following figure displays the view after extrapolation over the table.
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‘ Spark: N = 4600, L = 0.2. Cell filled with SPK.

4500.000 4000.000 5500.000

0.100 41.911 43.646 45211
0.200 36.956 38.628 40.114
0.300 31.923 33.243 34.37
0.400 26.840 27.568 28.148
0.500 21.500 21.435 21.498
0.600 15.353 14.676 14.552
0.700 9684 §.300 819
0.200 5.394 3977 3414
0.900 1.629 0.286 -0.504
1.000 -2.216 -3.407

Kl
I 36.9563
T 7.4852
T oglo =] 0T ; -
E'-2D A 0

m
= 1 T
= oo RO . RS
| | :
z Lo ] oo
G 200 / :
E R ¢ 50 |-+
o L= :

0 20 40

SPK

Note Not all the points in the lookup table will necessarily fulfill the
requirements of maximizing torque and restricting the NOx emissions.

The calibrator could now take these techniques to further improve the
calibration. That is not the purpose of this tutorial.

For a more detailed description of tradeoff calibrations, see “Tradeoff
Calibrations” on page 9-1.

You can now export this calibration for the electronic control unit.
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3 Tradeoff Calibration Tutorial

Exporting Calibrations

3-18

To export your table and its normalizers:
1 Select the Spark node in the branch display.
2 Select File —> Export —> Calibration.

3 Choose the type of file you want to save your calibrations as. You can choose
from
= Comma Separated Value (.csv)
= MAT-file (.mat)
= M-file script

4 For the purposes of this tutorial, select Comma Separated Value (.csv).

5 Enter tradeoff.csv as the file name and click Save.

This exports the spark angle table and the normalizers, Speed and Load, ready
for the ECU.

You have now completed the tradeoff calibration tutorial.
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4 Data Sets Tutorial

You can use the Data Sets view in CAGE to compare features, tables, and
models with experimental data. You can use data sets to plot the features,
tables, etc., as tabular values or as plots on a graph.

Data sets enable you to view the data at a set of operating points. You can
determine the set of operating points yourself, using Build Grid. Alternatively,
you can import a set of experimental data taken at a series of operating points.
These operating points are not the same as the breakpoints of your tables.

This tutorial takes you through the basic steps required to compare a
completed feature calibration to a set of experimental data:

¢ “Setting Up the Data Set” on page 4-3 describes the processes required to set
up a data set for a comparison.

¢ “Comparing the Items in a Data Set” on page 4-8 describes how to view
different aspects of the data set.

¢ “Reassigning Variables” on page 4-15 describes how to alter the data set.

For information about calibrating a feature, see “Feature Calibrations” on
page 8-1.

You can also use data sets to fill lookup tables from experimental data. For
information, see “Filling Tables from Data Tutorial” on page 5-1.
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Sefting Up the Data Set

Setting Up the Data Set

Start CAGE by typing
cage

at the MATLAB prompt.

Note If you have a CAGE session open, select File —> New -> Project.

To set up the data set:
1 Open an existing calibration.
2 Import the experimental data.

3 Add the Torque feature to the data set.

Your data set contains all the input factors and output factors required. As the
imported data contains various operating points, this information is also
included in the data set.

The next sections describe these processes in more detail.

When these steps are complete, the list of factors includes four input factors
and four output factors, as shown.
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4 Data Sets Tutorial

4-4

) CAGE Browser - datasettut.cag o ] B4
File Edit Yiew Data Tools ‘Window Help
D2R[(& X [EMize e
Processes Data Set [Data Set Factors
] New Dalaset Factor | Status | Unitz | 1k
xXn @3 Input
X load % Input
X afr @3 Input
T EARAE X zpk Input
] nmeas Output; Data
tgmeas Output: Data
¥y Torque: Model I Output: Feature
ii.Torque: Strateqy TP Output: Feature
. Project Expressions
Ewpreszion | | it | Branch | Tupe | Info
X afr Wariable  In data zet
X load Yariable  In data set
Xn Wariable  In data zet
X szpk Yariable  In data zet
11 Branch1 Table
/12 Branch1 Table
/13 Branch1 Table
4\ TORGUE Model
ii.Torque: haodel Branch 1 Feature  In data set
¥y Torque: Strateqy Branch1 Feature  Indata get

To open this file:

Opening an Existing Calibration

For this tutorial, use the file datasettut.cag, found in the
matlab\toolbox\mbc\mbctraining directory.



Sefting Up the Data Set

1 Select File —> Open Project.

2 In the file browser, select datasettut.cag and click Open.

This opens a file that contains a complete calibrated feature with its associated
models and variables. This particular feature is a torque calibration, using a
torque table (labeled T1) and modifiers for spark (labeled T2) and air-fuel ratio
(labeled T3).

For information about completing a feature calibration, see “Feature
Calibrations” on page 8-1.

3 Select File —> New —> Data Set to add a new data set to your session.

This automatically switches you to the Factor Information pane of the data
set display.

Importing Experimental Data into a Data Set
To import data into a data set:
1 Select File —=> Import —> Data.

2 In the file browser, select meas_tq_data.xls from the mbctraining
directory, and click Open.

This set of data includes six columns of data: the test cell settings for engine
speed (RPM), and the measured values of torque (tgmeas), engine speed

(nmeas), air-fuel ratio (afrmeas), spark angle (spkmeas), and load (1oadmeas).

3 The Data Set Import Wizard asks which of the columns of data you would
like to import. Click Next to import them all.

The following screen asks you to associate variables in your project with
data columns in the data.

4 Highlight afr in the Project Assignments column and afrmeas in the Data
Column, then click the assign button, shown.

<
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4 Data Sets Tutorial

4-6

5 Repeat this to associate 1load with loadmeas, n with RPM, and spk with
spkmeas. The dialog box should be the same as shown.

-} Data Set Import Wizard _1O| =]
— Match data columng in right list to project expressions in left list
Mote: Unazzigned columng will be treated az output data
Froject dezignments Drata Columng
Praject | [rata Calurin M arne | Colurn
X afr afimeas X afrmeas 4
X load loadmeas X Iloadmeas 3
Xn RFM o nmeas 2
X spk spkrmeas PR x RPM 1
X spkmeaz b
® tgmeas B
a | B <] |+
<- Back | Firizh | Cahicel
Assign button

6 Click Finish to close the dialog box.

Note If you need to reassign any inputs after closing this dialog you can

click B or select Data —> Assign.




Sefting Up the Data Set

Adding an Item to a Data Set
To add the Torque feature to the data set:

1 Highlight the Torque feature in the lower list of Project Expressions.

2 Select Data —> Factors —> Add to Data Set.

This adds two objects to the data set: Torque: Model and Torque: Strategy.
These two objects make up the Torque feature.

® Torque: Model is the model used as a reference point to calibrate the feature.
® Torque: Strategy is the values of the feature at these operating points.
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4 Data Sets Tutorial

Comparing the ltems in a Data Set

By viewing the data set, you can compare experimental data with calibrations
or models in your project.

Viewing the Data Set as a Table

Click m in the toolbar to view the data set as a table of values.

n load afr spk nmeas | tgmeas Torgue: Model|Torgue: Strateg

1 2235.000 0.549 9,500 0100 |2247.000 | 6G.700 71666 GE.079 -]
2 3591.000 0.454 13.200 0100 |3613.000 | 54.100 47 163 46.891

3 4546.000 0.641 12.000 0.100 | 4374000 | 73.700 474873 74.256

4 881.000 0.648 11.800 5.700 881.000 | 75.800 99,230 80.211

3 2234.000 0.441 13.300 0100 |2247.000 | 55.900 51.256 45142

B 3591.000 0.747 10,800 0100 |3612.000 | 90.000 92 837 105.586

7 4547.000 0.541 9,700 0.100 |4373.000 | 62.800 57760 57.587

8 881.000 0.622 9.900 0.100 884.000 | 72100 TE.198 BO0.926

g 1219.000 0.333 14.000 0100 |1224.000 | 41.800 33,226 21.318

10 1558.000 0.382 12.000 0100 |1567.000 | 49400 40,487 31957

11 1896.000 0.209 10.700 3.300 |1906.000 | 28.500 3.492 4197

12 2234.000 0.284 9.800 3.200 | 2245000 | 36.000 23.063 15.891

13 2574.000 0.407 13.400 3.000 | 2588.000 | 49.900 49,629 44.794 |
14 2514.000 0.585 11.500 3100 | 2925000 | 70500 84 680 82229

18 3251.000 0.781 12.300 3100 | 3268.000 | 90.500 117.424 117.254

16 3589.000 0.668 13.500 3.000 |3608.000 | ¥7.100 87 887 4F.408

17 35830.000 0.452 11.900 3.100 | 3942.000 | 52.700 46,511 51.722

18 4268.000 0.235 10,800 3.000 [4293.000 | 27 700 52583 3085

19 4606.000 0.194 12.000 3.200 | 4633.000 | 21.300 -2.088 -8.771

20 4545000 0.550 10100 3100 |48972.000 | &1.600 55,754 B5.743

21 5284.000 0.727 12.600 5.000 |5310.000 | 79.900 78,438 102468

22 5621.000 0.763 11.300 3.000 |5645.000 | 83.900 75 6549 102 957

23 A5861.000 0.500 13.200 3.000 | 5995000 | 51.700 35.034 A1.304

24 882.000 0.5857 12100 4.400 88Y.000 | B4.100 82 455 B2 160 j

In the table, the input cells are white and the output cells are blue.

In addition to viewing the difference between columns, you can use data sets to
create a column that shows the difference between two columns:

1 Select the tgmeas and Torque: Strategy columns by using Ctrl+click.
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Comparing the ltems in a Data Sef

2 Select Create Error from the right-click menu on either column header.

This creates another column that is the difference between tqmeas and Torque:
Strategy.

nol..|afr| spk toymeas | Torque: Model Torgue: Strategy tgmeas_minus_Torgue
1 3 N = T 1 I -
2 = I P R
3 1101
4 B... 1. 0487.
3 o110
f = I P R
7 4. |80,
8 Bl .. 9. 01,
g A A
10 L0
11 L33
12 B..|..|9..032.
13 o130
14 Bl 1.3
14 B 13
16 B 130
17 B 13
18 4. .. 1,30
19 1132
20 4o 1.3
21 A .. |1.. 580
22 o130
23 A |1.3.0.. -
4 »

The error column is simply the difference between tgmeas and Torque:
Strategy. This provides a simple way of comparing the feature and the
measured data.

Viewing the Data Set as a Plot

1 Click Q or select View —> Plot to view the data set as a plot.

The lower pane lists all the output expressions in the data set and in the
project.
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4 Data Sets Tutorial

2 Use Ctrl+click to select tgmeas and Torque: Strategy from the lower list.

& Torque: Strateqgy
& lomeas
Torgue ; Strategy, tameas v n
L I T T I I A L _Er R S T L R
: *e ' L » & ; -
: : ‘e : : L L
W A S o ... %
100 - » . bd [ L ] . " [ ] @
¢ & S P 5 .
L SUUUUR ... . TR TN PSRN SIS SO
: : : : & :
g : . 5 '
ﬁ [S10 - TR ........................................ . .......................... ' ...........................
3 . ° 1 B .
u\.? a0 i R S SN A ST S
* : .
0. [ ..................... F S AP
T IR URUURUROE. TSNS ORI SURR SUUROR W
| 1 I 1 1 | I 1 | I I
1000 1500 2000 2500 F000 3500 4000 4500 2000 2500 &000
n
w-awis factar: |p j y-awig factor. | <Selection: j

3 Change the x-axis factor to n from the drop-down menu.

This displays the calibrated values of torque from the feature, and the
measured values of torque from the experimental data, against the test cell
settings for engine speed.

Clearly there is some discrepancy between the two.
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Comparing the ltems in a Data Sef

Displaying the Error

View the error between the calibrated and measured values of torque.

-} CAGE Browser - datasettut.cag 1O =]
File Edit Wiew Data Tools Window Help

D@ x| F2| 2 EmEe @Wer

P Data Set
[Ehasks Gcioka Absolute Relative Errar (%2 (fgmeas - Targque) v n
: : : *

& | ] meas_tg data

T s S
=)
[=]
[l
o ODF ek SRILLILLILEE ELEMERILN SRR A
o £ . »

1 S BT T
f- : : : : : .
IE BD _ ............. ............. ............. ........... . ............
b o ) : : : : :
é 40!.5 ______ ." _______ P P DR
LR : . .,
| T P ‘ ......... * . @
= . * » : : . * = ‘

- F ;‘!‘ * % : 9 : 2. Select Absolute
- - 2 ' : L ¥ . ' G Relative Error

< om0 2000 3000 4000 5000 EO00

D ata Objects —{tqmeas - Torque)

w-aniz factor: In vl y-awiz factor;

Abzolute Rel

Output Exprezssions [Froject and Data Set]

E sprezzion | Branch | Type -
/12 Branch 1 Tahle
/13 Branch 1 Table
4\ TORGUE Models
23. Torque: Maodel Branch 1 Feature
¥y Torque: Strateqy Branch 1 Feature
Htgmeas D ata set Output
E—) tgmeaz_minuz_Torque Data zet Output =

4| | o

~—~1. Select tqmeas_minus_Torque
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4 Data Sets Tutorial

1 Select tgmeas_minus_Torque from the lower list (Output Expressions).

2 For the y-axis factor, select Absolute Relative Error (tqmeas - Torque)
from the drop-down menu.

As you can see, there seems to be no particular correlation between engine
speed and the error in the calibration.

Coloring the Display
1 Select Color by Value from the right-click menu on the graph.

2 From the color by drop-down menu, select 1oad.

Abzolute Relative Errar (%) (tgmesas - Torgue) v n Iz
: : : : . : . : : :
120k PR ....... L R Ceeee L ....... L RPN 0Es

T : : : : : : : : : : :
S0k Ll L T I Lo 074
g : : : : : : : : : : :
= :
= : . :
i : S : : : : 5 : : :
E =11 SR [T e e P e IR RERRRE e 4062
= : : : : : : : : : : :
=
E : : : : :
il : : : : . : . : : : : F 4051
E ED_ ....... IEERRRE ....... \.‘ ....... ....... [ERERERE ....... \, ....... .....
fre} : : : : : : : : : : :
) : : : : : : : : : : :
= W - ! . . : . : : .
=S SHE T S S A 040
E ok L TERTERS - ERPIRE I Lo TRETEES P RRPRE I
(O
H : E L : : e :
N L N I T . he
T O20F F P #o A L PR S

: : . : i . [ : : [ )

: . * L : : : : [ ] L :

5 i . :

] i | | i ! i | i i I [ Limit range

1000 1500 2000 2500 3000 3500 4000 4500 5000 5500 6000
i Color by:
x-avis factar: In vl -axis Factor: I,.f_-.,bsgmte Helativ-j IIoad ﬂ

In this display, you can see that some of the low values of load display a high
error.
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Limiting the Range of the Colors

Iz
085
074 ) .
| Adjust the maximum
value of the range
Lwe-{0 62
| Adjust the mid
value of the range
-
0.40
Adjust the minimum
—value of the range
028
v Limit range L.
( ___Limit range
Coolor ba; check box
Ilnad 'I

To view the colors in more detail, you can limit the range of the colors:
1 Select the Limit range box.
2 Right-click on the graph and select Restrict Color to Limits.

3 Set the minimum value of the color range to be as low as possible by
dragging the minimum value down.

4 Set the maximum value of the color range to be around 0.4.
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4 Data Sets Tutorial

Abzolute Relative Error (%) (tgmeas - Torgue) v n losicd

120 _ ....... ....... s ........ ....... ....... ....... . ........ ....... .....

=
=
=

80—% ....... . R ....... ....... e ....... .......
50-% ....... ....... ....... ....... ....... ....... ..... o .......

A0L: e S ORI S L Lo L CERTRRREPPPTIE SO
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! 1 i i I Io ] i i i a p Lirnit range
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I Coolor by:

w-aiz factor In vI y-awiz factor; I,&bgglute Helativnj Ilnad j

As the low values of load are causing large errors, it would be wise to reexamine
the calibration, particularly at small values of load.
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Reassigning Variables

Reassigning Variables

Instead of using the test cell settings for the engine speed (RPM), you might
want to use the measured values of engine speed (nmeas). So you have to

reassign the variable n to nmeas.

To reassign n:

1 Click B or select Data —> Assign.

2 In the dialog that appears, select n from the Project Assignments pane and

nmeas from the Data Columns pane.

3 Click the assign button.

) Data Set Assign o ] 4
— hatch data coluring in right list to project expressions in left ist
Mote: Unagzigned columng will be treated az output data
Project Aszzignments Data Columng
Project | D ata Calumn MHane | Calurnn
X afr afrmeas X afimeas 4
X load loadmeas X loadmeaz 3
Xn nmeas g X nmeas 2
X zpk spkmeas P RPM 1
X zpkmeas ]
® tqmeas B
1] | B 1 | +]
[ Show all expressions
}Assigning nmeas o h; uhassighing data column RP. oK Cancel

You can now compare your calibration with your experimental data again,

using the techniques described.
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4 Data Sets Tutorial

For more information about the complete functionality of data sets, see “Data
Sets” on page 10-1.

You have now completed the data sets tutorial.
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5 Filling Tables from Data Tutorial

5-2

If you are considering a straightforward strategy, you might want to fill tables
directly from experimental data. For example, a simple torque strategy fills a
lookup table with values of torque over a range of speed and relative air charge,
or load. You can use CAGE to fill this strategy (which is a set of tables) by
referring to a set of experimental data.

This tutorial takes you through the steps of calibrating a lookup table for
torque, based on experimental data.

¢ “Setting Up a Table and Experimental Data” on page 5-3 describes the steps
required to set up CAGE in order to calibrate a table by reference to a set of
data.

¢ “Filling the Table from the Experimental Data” on page 5-10 describes the
process of filling the lookup table.

® “Selecting Regions of the Data” on page 5-14 describes how you can select
some of the data for inclusion when you fill the table.

¢ “Exporting the Calibration” on page 5-16 describes how to export your
completed calibration.



Setting Up a Table and Experimental Data

Setting Up a Table and Experimental Data

1 Start CAGE by typing
cage
at the MATLAB prompt.

2 Select File —> New Project.

This section describes how to set up a blank table ready for filling using
experimental data.

The steps that you need to follow to set up the CAGE session are
1 Add the variables for speed and load.

2 Add a new table to your session.

3 Set up your normalizers.

4 Import your experimental data.

The next sections describe each of these processes in detail.

Adding Variables

Before you can add tables to your session, you must add variables to associate
with the normalizers or axes.

To add a variable dictionary:
1 Select File —> Import —> Variable Dictionary.

2 Select table filling tutorial.xml from the
matlab\toolbox\mbc\mbctraining directory.

This loads a variable dictionary into your session. The variable dictionary
includes the following:

® N, the engine speed

® |, the relative air charge
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5 Filling Tables from Data Tutorial

e A the air-fuel ratio (AFR)
® stoich, the stoichiometric constant

You can now add a table to your session.

Adding a New Table
You must add a table to fill.

To add a new table:
1 Select File —> New —> 2D table.

This opens a dialog box that asks you to specify the variable names for the
normalizers.

2 To accept N as the variable for normalizer X and L as the variable for
normalizer Y, click OK.

Note In CAGE, a 2-D table is defined as a table with two inputs.

CAGE takes you to the Manual Calibration view, where you can see the
following.



Setting Up a Table and Experimental Data

:} CAGE Browser - Untitled o ] |
File Edit W%ew Table Tools ‘Window Help
D@ X|#F®|?||Ezo0®F
Frocesses t anual Calibration |
~| |4 Branchi :
04
=
0.5
07
0.6
w
4 r 05
Data Objects
0.4
0.3
0.2
04
pb—1 1

05

You must now set up and initialize the normalizers with suitable values for the

engine speed and load.
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Setting Up the Normalizers

Currently, the lookup table has neither rows nor columns, so you must set up

the table.
To set up the table:

1 Open the Calibration Manager dialog box, shown, by clicking ﬁ

<} Calibration Manager

CER®o o | @

Calibratable Blacks

A Branch 1

®-d MNew 20 Table
| «Mormalizer

o] yMormalizer

— Manual Setup

|_|:| Rows I—D Colurrs I_ Walue

Precizion: IEEE Double Precizion

Setllp |
Edit Precizian... |

| Contents of Cal File

Cal | 5ize |

Cal file:
[ata
Type:
Cal.
Imfa:

— Dizplay
Block: Mew_2D_Table

Cloze |




Setting Up a Table and Experimental Data

5

6

Highlight the New 2D Table in the Calibratable Blocks display.

To determine the size of each normalizer, enter 10 as the number of rows and
7 as the number of columns.

Set the value in each cell to be 0.
Click Set Up to confirm your selection.

Click Close to close the Calibration Manager and return to the table view.

Setting the Values of the Normalizers

You can now set values of the normalizers so that they cover the range of the
variables N and L:

Expand the table branch by clicking =, and select xNormalizer as shown.

t4anual Calibration |
A Branch 1

-l New_20_Table

L ed aNomalizer

: |/ wNormalizer
ol sNomalizer
bl uNomalizer

This displays the two normalizers for the table.

To space the breakpoints evenly over the range of the variables N and L,
click UL,

This opens a dialog box that suggests the range of values for each
normalizer.

To accept the suggested ranges of N and L, click OK. These suggested ranges
are determined by the variable dictionary.

You now have an empty table with breakpoints over the ranges of the engine
speed and load, which you can fill with values based on experimental data.
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Importing Experimental Data

To fill a table with values based on experimental data, you must add the data
to your session.

CAGE uses the Data Sets view to store grids of data. Thus, you need to add a
data set to your session as well.

Select File -> New —> Data Set to add a data set to your session. This changes
the view to the Data Set view.

You can now import experimental data into the data set:

2

Select File —> Import —> Data.

In the file browser, select meas_tq_data.csv from the
matlab\toolbox\mbc\mbctraining directory.

This set of data includes six columns of data: the test cell settings for engine
speed (RPM), and the measured values of torque (tgmeas), engine speed
(nmeas), air-fuel ratio (afrmeas), spark angle (spkmeas), and load (1oadmeas).

This opens the Data Set Import Wizard. The first screen asks which of the
columns of data you want to import. Click Next to import them all.

The following screen asks you to associate variables in your project with
data columns in the data.

Highlight N in the Project Assignments column and nmeas in the Data
Column, then click the assign button, shown.

4

Repeat this to associate L with 1oadmeas. The dialog box should be the same
as the following.



Setting Up a Table and Experimental Data

-} Data Set Import Wizard 1ol =l
— Match data columns inright ligt to project expressions in left izt
Mate: Unazzigned columns will be treated as output data
Project Azzignments D ata Columns
Froject | Data Column Hame | Column
¥ oA X afrmeas 4
xL loadmeas X loadmeas 3
x N nimeas 7 X hmess 2
« RPM 1
X spkmeas 5
x tqmeaz g
| i B l |+
™ Show all expressions
ak. Cancel

Assign button

6 Click Finish to close the dialog box.

You now have an empty table and some experimental data in your session. You

are ready to fill the table with values based on this data.
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Filling the Table from the Experimental Data

You have an empty table and the experimental data in your session. You can
now fill the table with values based on your data.

The data that you have imported is a series of measured values of torque at a
selection of different operating points. These operating points do not
correspond to the values of the breakpoints that you have specified. The lookup
table has a range of engine speed from 500 revs per minute (rpm) to 3500 rpm.
The range of the experimental data is far greater.

CAGE extrapolates the values of the experimental data over the range of your
table. Then it fills the table by selecting the torque values of the extrapolation
at your breakpoints.

To fill the table with values based on the experimental data:

1 To view the Table Filler display, click ﬁ in the toolbar in the Data Sets
view.

This display asks you to specify the table you want to fill and the factor you
want to use to fill it.

2 Inthe lower pane, select New_2D_Table from the Table list. This is the table
that you want to fill.

3 Select tgqmeas from the Factor list. This is the data that you want to use to
fill the table.

4 Select N from the x-axis factor list and L from the y-axis factor list. Your
session should be similar to the following display.
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W Show table histary after fil

The upper pane displays the breakpoints of your table as crosses and the

Select table to fill | Choose factar b fill table | T able filling rules [optional) |
Table Factor
’Q Mew 20_Table [ afrmeas Click and drag on 'Data Set’ plo
|/ wMomalizer EARPM
i'_"{ yMarmalizer [ spkmeas
E Iqmeas
KN I3 [ KT I3 N [

i
Fill T able |

operating points where there is data as blue dots.

5 To view the table after it is filled, ensure that the Show table history after
fill box, at the bottom left, is selected.

Data sets display the points in the experimental data, not the values at the

breakpoints.
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5-12

6 To fill the table with values of tqmeas extrapolated over the range of the
normalizers, click Fill Table.

This opens the History dialog box, shown.

-} History for New_2D_Table : |
W Ersion | Comment / Action | Date and Time |
3 Yalues filled from data zet meaz_tg data, factor tlgmeas 13-pap-2002 17.38:35
2 Setup 13-May-2002 17:35:53 Feset |
1 Created 13-pap-2002 17.35:09

4dd

Femove

Edit...

i

A00.000 1000000 1500.000 2000000 2500.000 3000000 3500.000
0100 12245 13.471 14 B37 15.084 14 622 13.805 13.044
0,200 23802 25.336 26.940 27.322 25,900 24.344 236497
0.300 35.140 36.987 38912 IB.876 365498 33.438 314811
0.400 46,028 45.217 51.119 a1.817 49,4490 45317 40,169
0.400 5F.8349 A8.411 60752 B2.247 521349 B1.778 52 486
0.600 G8.694 69,387 f9.545 69,367 £9.788 71.364 G8.274
0.700 79.019 789.285 78650 76.015 75704 82818 85471
0.200 88,482 858.408 42981 958.575 92016 91.030 §93.019
0.900 104147 106.248 110.804 114.302 112183 107.478 107.431
1.000 121.640 123.967 126,968 1249.007 128826 127.695 127 643

Cloze Help

7 Click Close to close the History dialog box and return to the Table Filler
display.

8 To view the graph of your table, as shown, select Data —> Plot —> Surface.




Filling the Table from the Experimental Data

Tahle

120
100

=1]
40
20

Filling takle New2DTable, from factar tgmeas

gn.. ...

This display shows the table filled with the experimental points overlaid as
purple dots.

The table has been calibrated by extrapolating over the values of your data and
filling the values that the data predicts at your breakpoints.

Notice that the range of the table is smaller than the range of the data, as the
table only has a range from 500 rpm to 3500 rpm.

The data outside the range of the table affects the values that the table is filled
with. You can exclude the points outside the range of the table so that only
points in the range that you are interested in affect the values in the table.
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Selecting Regions of the Data

You can ignore points in the data set when you fill your lookup table.

For example, in this tutorial the experimental data ranges over values that are
not included in the lookup table. You want to ignore the values of engine speed
that are greater than the range of the table.

To ignore points in the data set:

1 Select Data —> Plot —> Data Set. This returns you to the view of where the
breakpoints lie in relation to the experimental data.

2 To define the region that you want to include, left-click and drag the plot.
Highlight all the points that are included in your table range, as shown.

1.00% -
080z
0&0F -
070 -
060 -
0s0F -
040z
0.30% -
020% -

010
50000 100000 150000 200000 250000 300000 350000

w-aiz factor IN j y-awiz factor: ||_ j

3 To fill the table based on an extrapolation over these data points only, click
Fill Table. This opens the History display again.

4 In the History display, select version 3 and 4, using Ctrl+click. The
following display shows a comparison between the table filled with two
different extrapolations.
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Selecting Regions of the Data

J History for New_2D_Table x|
Werzion | Comment / Action | Date and Time |
5 Walues filed from data zet meas_tq data, factor tqmeas 13May-2002 14:00:39
4 Walues filed from data zet meas_tq_data, factor lgmeas 13-Map-2002 14:00:03 Heset |
3 Walues filed from data zet meas_tq data, factor afrmeas 03 ay-2002 16:20:43
2 Setup 03-bdap-2002 16:12:23 Add
1 Created 03 ay-2002 16:11:56

Remowe

Edit...

It

500.000 1000.000 1500.000 2000.000 2500.000 3000.000 3500.000
0.100 -0.713 -0.156 03745 0.910 1.463 2.002 2.4581
0.200 -0.754 -0.231 0223 0.6893 1.254 1.867 2414
0.300 -0.748 -0.245 0.055 0.330 0.826 1.473 2.041
0.400 -0.EE2 -0.041 0130 0.014 0280 0.800 04905
0.500 -0.817 0.241 0.966 0.871 0.280 -1.070 -2.408
0.600 -1.1549 0.475 2739 3.858 1.159 -7.BRD -18.893
0.700 -1.274 0.617 3227 G.894 4,291 -12.476 -33.844
0.800 -1.702 -0.486 -0.145 -2.803 2781 -2.902 -11.124
0.900 -2.546 -2.378 -3.151 -3.468 -1173 1.585 5.909
1.000 -2.803 -2.644 -2.470 -1.472 1.054 4776 8.050

Cloze Help

5 Click Close to close the History viewer.

6 Select Data —> Plot —> Surface to view the surface again.

The display of the surface now shows the table filled only by reference to the
data points that are included in the range of the table.

You have filled a lookup table with values taken from experimental data.
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5-16

Exporting the Calibration

You can export the calibration for use in an electronic control unit (ECU).

To export the calibration:

5

6

To highlight the table that you want to export, you must first click Manual
Calibration, shown.

Highlight the New_2D Table.
Select File —> Export —> Calibration.

Choose the type of file you want to save your calibrations as. You can choose
from

a Comma Separated Value (.csv)
b MAT-file (.mat)
¢ M-file script

For the purposes of this tutorial, select Comma Separated Value (.csv).

Enter table filling_tutorial.csv as the file name and click Save.

This exports the successful calibration, ready for the ECU.

You have now completed this tutorial.
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6 using CACGE

The following reference sections describe how to use CAGE to perform
calibrations:

¢ “How to Use CAGE” on page 6-3 is an overview of CAGE processes: where to
find the functionality for different processes and how to set up variables and
models before performing calibrations.

® “Normalizers” on page 7-1 describes what normalizers are, and how to space
breakpoints in a normalizer.

¢ “Feature Calibrations” on page 8-1 describes how to calibrate lookup tables
by reference to models built using the model browser.

¢ “Tradeoff Calibrations” on page 9-1 describes how to calibrate lookup tables
by adjusting one value to fulfill different objectives.

¢ “Data Sets” on page 10-1 describes how to use CAGE to compare calibrations
to experimental data, and how to use experimental data to fill lookup tables.

¢ “Calibration Manager” on page 11-1 describes how to use the Calibration
Manager.

¢ “Surface Viewer” on page 12-1 describes how to use the Surface Viewer.

¢ “Manual Calibration and the History Display” on page 13-1 describes how to
add and delete tables and manually calibrate tables; and how to use the
History viewer.
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How to Use CAGE

Before you can perform a calibration using CAGE, you need to set up the
variables, constants, and the models you want to use. If you import a model, it
has variables associated with it, in which case you might not have to import a
variable dictionary.

The following sections describe how to set up variables and models before
performing calibrations:

¢ “Setting Up Your Variable Items” on page 6-7

¢ “Setting Up Your Models” on page 6-14

You can also use CAGE to calibrate tables directly from experimental data by

interpolation, without using models. See “Filling Tables from Data Tutorial” on
page 5-1 for an example.

The view and functionality available in CAGE depend on two things:

® Which of the six large buttons you select in the Processes and Data Objects
panes

¢ The item you highlight in the branch display (tree)

See the next section, “CAGE Views and Processes” on page 6-4, for a summary

of the functionality you can reach in each view and links to in-depth help for
each process.
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6-4

CAGE Views and Processes

Processes

S

Tradeaff

The Processes pane has three buttons:

¢ Feature shows the Feature view, with the tables and strategies that are

associated with that feature. See “Feature View” on page 8-45.

A feature is a strategy (or collection of tables) and a model used to calibrate
those tables. In the Feature view, you can fill tables by comparing a strategy
to a model. See “Feature Calibrations” on page 8-1. You can import existing
strategies or construct new ones using Simulink from the feature view.

From the feature node in the branch display, you can access the Surface
Viewer to examine the strategy or model or both. See “Surface Viewer” on
page 12-1.

Manual Calibration enables you to calibrate tables manually. It also acts as
a store for all the tables and normalizers in your session. Here you can add
and delete tables from the project. From any table display (here, or in other
views) you can access the History Display to manage changes in your tables
and normalizers. You can use the History Display to reverse changes. See
“Using the History Display” on page 13-5.

Tradeoff shows the Tradeoff view, with a list of the tables and models to
display. Here you can see graphically the effects of manually altering
variables to trade off different objectives (such as maximizing torque while
minimizing emissions). At the tradeoff node, you can calibrate table values
to achieve the best compromise between competing objectives. You can



How to Use CAGE

calibrate using single or multimodel tradeoffs. See “Tradeoff Calibrations”
on page 9-1.

You can reach the Calibration Manager from any of the three Process
views. Here you can set up the size of tables (manually or using existing
calibration files) and edit the precision used for values (to match the kind of
electronic control unit you are going to use). See “Calibration Manager” on
page 11-1.

[ ata Objects

Madlels

The Data Objects pane has three buttons:

¢ Variable Dictionary stores all the variables, constants, and formulas in
your session. Here you can view, add, and edit any variables in any part of
your session. See “Setting Up Your Variable Items” on page 6-7.

® Models stores all the models in your session. Here you can view a graphical
display of these models, including a diagram of the model’s input structure.
This is useful because a model can have other models as inputs. You can
change the inputs here. For example, you can change your model’s input
Spark to be connected to a model for Spark rather than to the variable Spark.
You can also access the surface viewer here to examine models. See “Setting
Up Your Models” on page 6-14 and “Surface Viewer” on page 12-1.

¢ Data Sets enables you to evaluate your models and features over a custom
set of input values. Here you can create and edit a set of input values and
view several models or features evaluated at these points. You can compare
your tables and models with experimental data to validate your calibrations.
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You can also fill tables directly from experimental data by loading the
experimental data as a new data set. See “Data Sets” on page 10-1.



Sefting Up Your Variable ltems

Setting Up Your Variable Items

The Variable Dictionary is a store for all the variables, constants, and
formulas in your session.

To view or edit the items in the Variable Dictionary, click the button, shown,
in the Data Objects pane.

Selecting the Variable Dictionary view displays the variables, constants, and
formulas in the current project.

This section describes the following:
¢ “Importing and Exporting a Variable Dictionary” on page 6-9
¢ “Adding Variable Items” on page 6-10

¢ “Using the Variable Menu” on page 6-12
¢ “Using Aliases” on page 6-13

Following is an example of the Variable Dictionary view.
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List of all the constants, variables, and formulas in the project

‘} CAGE Browser - Untitled X 101 =l
File Edit Variable Tools ‘Windolw Help

Deax[#E2p R D

Processes Wariable Dic}{:unary

~ | Mame /1 Tupe | Aliaz | Minimuml Mar:imuml Set F'Dintl Formula |
x N/ Vaiable engine_zpeed R00 E500 2500
xL Yariable  load, Load 01 1 0.4
XA Yariable  afr, AFR 11 17 14.35

. k stoich  Constant 1435

x SPK Yarable S, s, zpark 10 B0 2248
fixhlambda  Formula 075 1.25 1 Afstoich
A
Alias: | ar. &FF;

i Drescription; I Air-fuel ratio [ratio)

: L b inirnam: I 1 il I airmuim: I 17 i‘
Set Paint: [ 143 3

Farmula; I

Edit boxes to change the settings of the
selected constant, variable, or formula
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The upper pane shows a list of all the current variables, constants, and
formulas. The lower pane displays edit boxes so you can specify the settings of
the selected variable, constant, or formula.

Importing and Exporting a Variable Dictionary

A variable dictionary contains all the variable items for your calibrations. You
can set up your variable dictionary once, and use it in many calibrations.

Importing a Variable Dictionary
To import a dictionary of variables from an .xm1 file:

1 Select File —> Import —> Variable Dictionary.

2 Select the correct dictionary.

Exporting a Variable Dictionary

After setting up a variable dictionary, you can save the dictionary for use in
many different calibrations.

To export a dictionary of variables to an .xml file:
1 Select File —> Export —> Variable Dictionary.

2 Select a suitable name for the dictionary.

See Also

¢ “Setting Up Your Variable Items” on page 6-7
¢ “Adding Variable Items” on page 6-10
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6-10

Adding Variable ltems

To add variable items you can use the Variable Dictionary toolbar, shown, or
you can select items from the File -> New —> Variable Items menu.

Variable Dictionary Toolbar

Add a variable Add o constant Add a formula

Adding a Variable

To add a variable:
1 Select File —> New —> Variable Item —> Variable.
A new variable is added to the variable dictionary.
2 Select Edit —> Rename to alter the name of the variable.

3 Specify the Minimum and Maximum values of the variable in the edit boxes
in the lower pane.

4 Specify the value of the Set Point in the edit box.

Using Set Points in the Variable Dictionary. The set point of a variable is a point that
is of particular interest in the range of the variable.

For example, for the air-fuel ratio variable, AFR, the range of values is
typically 11 to 17. However, whenever only one value of AFR is required, it is
preferable to choose 14.3, the stoichiometric constant, over any other value. So
enter 14.3 as the Set Point.

CAGE uses the set point as the default value of the variable wherever one value
from the variable range is required. For instance, CAGE uses the set point
when evaluating a model over the range of a different variable.

For example, a simple model for torque depends on AFR, engine speed, and
relative air charge. CAGE uses the set point of AFR when it calculates the
values of the model over the ranges of the engine speed and relative air charge.
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Adding a Constant

To add a constant:
1 Select File -> New -> Variable Item -> Constant.
A new constant is added to the variable dictionary.

2 Select Edit —> Rename to alter the name of the constant.

3 Specify the value of the constant in the Set Point edit box, in the lower pane.

Adding Formulas

You might want to add a formula to your session. For example, the formula

afr
stoich

where afr is the air-fuel ratio and stoich is the stoichiometric constant.

To add a formula:
1 Select File -> New —>Variable Item —> Formula.

The Add Formula dialog box appears.

2 In the dialog, enter the right side of the formula, afr/stoich, and click OK.

A new formula is added to the variable dictionary.

3 Select Edit -> Rename to alter the name of the formula.

Note Formulas can only have one variable.

See Also

® “Setting Up Your Variable Items” on page 6-7
¢ “Adding Variable Items” on page 6-10
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Using the Variable Menu

The Variable menu in the variable dictionary enables you to alter variable
items.

Change item to

* Alias
Changes the selected item to be an alias of another item in the current
project. For example, if you have two variables, engine_speed and n, you can
change n to be an alias of engine_speed, with its maximum and minimum
values. For more information, see the next section, “Using Aliases” on
page 6-13.

¢ Formula

Changes a variable or constant into a formula. You have to define the right
side of the formula, and use the edit boxes to change the ranges.

® Constant

Changes a variable or formula into a constant. The value of the constant is
by default the midpoint of the variable’s range.

® Variable

Changes a constant or formula into a variable. The minimum value of the
variable is, by default, the value of the constant, and its maximum is, by
default, twice the minimum value.

See Also

¢ “Setting Up Your Variable Items” on page 6-7
¢ “Using Aliases” on page 6-13
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Using Aliases

The variable dictionary enables you to use the same set of variables, constants,
and formulas with many different models and calibrations.

Why Use Aliases?

It is possible that in one model the engine speed has been defined as N, and in
another it has been defined as rpm. The alias function enables you to refer to
the same quantity by a variety of different names.

Creating an Alias
For example, in a variable dictionary there are two variables:

® N with a range of 500 to 6500
® rpm with a range of 2500 to 3500

To set rpm to be an alias of N:
1 Highlight the variable rpm.
2 Select Variable -> Change item to —> Alias.

3 In the dialog, choose N from the list.

This eliminates the variable rpm from your variable dictionary, and every
model and calibration that refers to rpm now refers to N instead.

Note IfNis made an alias of rpm in the preceding example, the range of N is
restricted to the range of rpm, 2500 to 3500.

See Also

¢ “Setting Up Your Variable Items” on page 6-7
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Setting Up Your Models

6-14

CAGE generally calibrates lookup tables by reference to models. The Models
view is a storage place for all the models in your session.

To view and edit the models in your session, select Models by clicking the
button shown in the Data Objects pane.

This section describes the following:

¢ “Importing Models” on page 6-16

¢ “Adding New Function Models” on page 6-18
¢ “Renaming and Editing Models” on page 6-19
The Models view displays the following:

¢ A list of all the models in the current project.

¢ The model connections. That is, which constants, variables, and models are
linked to the selected model.

® An image of the response surface of the selected model.

Following is an example of the Models display.
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List of the current models

:} CAGE Browser - Untitled : B ] B
File Edit Model Tools ‘Window Help

losd|X|#Fa?

Processes kodelz |
~| | Mame | Tupe | Inputs | Degcription |
kg MEC madel spk [N, LA
M MBT_Spatk  MBC model L.M.AE
" Spark Function model  WMBT_Spark min[30.MBT_Spark]
Connections Spark

30 ~

23+

20 ~

13 4

3000
2000

1000

10 4

Models

&

x-axiz factor: y-axiz factor:

I ] @ B

Bl

e i i | 3

Model connections display Model display
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Importing Models

CAGE enables you to calibrate lookup tables by referring to models constructed
in the Model Browser.

To import a Model Browser model:
1 Select File —> Import —> Model.

This opens the Model Import Wizard. The following steps take you through
the three screens of the wizard.

2 Select the correct file by clicking J to browse for the correct file.

3 CAGE can only open Model Browser files.

a Ifthe model is saved as an .exm file, select Automatic from the Open As
drop-down menu.

b If the model is not saved as an .exnm file, select MBC Model from the
Open As drop-down menu. For example, the file extension might be
accidentally changed.

4 Click Next > to select the model file.

5 Select the models that you want to import by highlighting the models from
the list.

6 Click Next > to select the models.
7 Associate the model factors with the available inputs in your session.

For example, to associate the model factor spark with the variable spk in
your session:

6-16
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<} Model Import Wizard a8 B ]
Model factors: Available inputs:
Syumbol | Agzigned Input | EJ ;I
Tt A
ztoich
[~ Copy range LI
Factar range: | .34 B0.8 Input range: 10 B0
Cancel | ¢ Back | fdewt > | Finigh |

a Highlight a model factor, spark, in the list on the left and the
corresponding variable, spk, in the list on the right.

b Click the select input button, shown.

¢ Repeat 7a and 7b for all the model factors.

8 Click Finish to close the wizard and return you to the Models view.

Note You can skip steps 6 and 7 by selecting the Automatically assign/
create inputs box at step 5.

You can now see a display of the model surface and the model connections.

See Also

¢ “Setting Up Your Models” on page 6-14
¢ “Adding New Function Models” on page 6-18
¢ “Renaming and Editing Models” on page 6-19
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Adding New Function Models

A function model is a model that is expressed algebraically.

For example, you might want to view the behavior of torque efficiency. So you
create a function model of torque efficiency = torque/peak torque.

To add a function model to your session:
1 Select File => New —> Function Model.
This opens the Function Model Wizard.

2 In the dialog box, enter the formula for your function model. For example,
enter torque_efficiency=torque/peak_torque.

3 Press Enter. CAGE checks that the function is recognized; if so, you can
click Next >. If the function is incorrectly entered, you cannot click Next.

4 Select the models that you want to import by highlighting the models from
the list.

5 Click Next > to select the models.
6 Associate the model factors with the available inputs in your session.

For example, to associate the model factor peak_torque with the
peak_torque model in your session:

<) Function Model Wizard - I ] |
Model factors: Available inputs:
Symbaol | Azzigned Input ¥ ﬂ
peak_torque peak_torque
e
torque torque Fr_Model
MBT_Model
t
[ Copy range mraue hut
Factar range: | g 100 Input range:
Cancel | < Back | Mext s | Finizh |
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a Highlight a model factor, peak_torque, in the list on the left and the
corresponding model, peak_torque, in the list on the right.

b Click the select input button, shown.

¢ Repeat 7a and 7b for all the model factors.

7 Click Finish to close the wizard and return you to the Models view.

Note You can skip steps 6 and 7 by selecting the Automatically assign/
create inputs box at step 5.

You can now see a display of the model and its connections.

See Also

¢ “Setting Up Your Models” on page 6-14
¢ “Importing Models” on page 6-16
¢ “Renaming and Editing Models” on page 6-19

Renaming and Editing Models

Renaming Models
To rename a model:

1 Highlight the model that you want to rename.
2 Select Edit —> Rename.

3 Enter the new name for the model and press Return.

You can also rename the model by selecting a model and clicking the name.
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6-20

Editing Ranges of Model Factors

To edit the ranges of the model factors in the currently selected model:
1 Highlight the model that you want to edit.
2 To change the ranges of the model factors, select Model —> Properties.

This opens the Model Properties dialog box, shown.

<) Model Properties Ol =]

Model factors: Available inputs:

Symbol | Azzigned [nput

A A

L L Tt

M M

1] | Mo Copy range " =l
Factor range: [ 1091 I 14.65 Input range: 500 £500

Caticel | < Back | MHiEst > | Finizh |

3 Highlight the model factor that you want to alter.

4 Enter the new range in the Factor range boxes.

Note This does not change the range of the variable over the entire project;
rather, it changes the range of the variable in the selected model. If you want
to change the range of a variable in the entire session, change the range in the
variable dictionary. For more information, see “Using the Variable Menu” on
page 6-12.

Editing Model Connections

You can adjust a model so that variables, formulas, or other models are the
factors of the model. For example, a model of torque depends on the spark
angle. In place of the spark angle, you can have a model of the maximum brake
torque (MBT).
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To edit the connections of a model:
1 Highlight the model.
2 Select Model —> Properties.
This opens the Model Properties dialog box.
3 Highlight the model factor that you want to adjust, in the list on the left.
4 Highlight the new input for that factor, in the list on the right.

5 Click the Select Input button, shown.

6 To close the dialog box, click Finish.

Example of Editing the Connections of the Model

<} Model Properties 5 101 =l
Model Factors: Available inputs:
Symbaol | Azzigned Input | SPK ;I
2 2 zshaich
L L #
M M Tt
zpark SPE
[~ Copy range
Factor range: - | g4 50.8 |nput range:
6. Click
Cancel | < Baik | st > | Finish T_Finish.
3. Highlight the model factor that you 5. Click Select Input. 4. Highlight the new input.

want to change.
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Exporting Calibrations

6-22

When you have filled some tables using any of the CAGE processes, you can
export the tables.

1 Select File —> Export —> Calibration

2 Choose the type of file you want to save your calibrations as. You can choose
from

a Comma Separated Value (.csv)
b MATLAB-file (.mat)
¢ M-file script

3 Enter the file name and click Save.

What you export depends on which node is highlighted:

¢ Selecting a Normalizer node outputs the values of the normalizer.

¢ Selecting a Table node outputs the values of the table and its normalizers.

¢ Selecting a Feature or Tradeoff node outputs the whole feature or tradeoff
(all tables and nodes).

Selecting a branch node outputs all the Features or Tradeoffs under the
branch.
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Specifying Locations of Files

You can specify preferred locations of project and data files, using File —>
Preferences.

Project files have the file extension .cag and store entire CAGE sessions.

Data files are the files that form part of the CAGE session. For example, the
following is a list of some of the data files used in CAGE:

¢ Simulink diagrams (.md1)

¢ Experimental data (.x1s, .csv, or .mat)
e Variable dictionaries (.xml)

® Models (.exm)

To specify preferred locations for project and data files:

1 Select File —> Preferences. This opens the dialog box shown.

~) CAGE Options a =10l x|

CAGE project files directony:

[ =

CAGE data files directan:

| =]

ak | Cahicel |

2 Enter the directory where your CAGE project files are stored. Alternatively,
click & to browse for the directory.

3 Enter or browse for the directory where your data files are stored.

4 Click OK.
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7 Normalizers

A normalizer is the axis of your lookup table. It is the same as the collection of
the breakpoints in your table.

This section includes the following:
¢ “About Normalizers” on page 7-3 describes what normalizers and
breakpoints are.

¢ “Calibrating the Normalizers” on page 7-4 describes how to calibrate
normalizers by spacing the breakpoints.

® “Normalizer View” on page 7-14 describes what you can see when you
highlight a normalizer in the branch display.
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About Normalizers

CAGE distinguishes between the normalizers and the tables that they belong
to.

Using models to calibrate lookup tables enables you to perform analysis of the
models to determine where to place the breakpoints in a normalizer. This is a
very powerful analytical process.

It is important to stress that in CAGE a lookup table can either be one
dimensional or two dimensional. One-dimensional tables are sometimes known
as characteristic lines or functions. Two-dimensional tables are also known as
characteristic maps or tables. This is important to stress, as normalizers are
very similar to characteristic lines.

For example, a simple strategy to calibrate the behavior of torque in an engine
might have a two-dimensional table in speed and relative air-charge (a
measure of the load). Additionally, this strategy might take into account the
factors of air-fuel ratio (AFR) and spark angle. Each of these compensating
factors is accounted for by the use of a simple characteristic line. In CAGE,
these characteristic lines are one-dimensional tables. In the example strategy,
there are the following tables and normalizers:

® One characteristic map: the torque table
¢ Six characteristic lines:
= Two tables: one for AFR and one for spark angle
= Four normalizer functions: speed, load, AFR, and spark angle
Notice also that a breakpoint is a point on the normalizer where you set values
for the lookup table.

Thus, when you calibrate a normalizer you place the individual breakpoints
over the range of the table’s axis.
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Calibrating the Normalizers

Select a normalizer in the branch display. This enables you to calibrate the
normalizer, and it displays the Normalizer view.

For more information about the Normalizer view, see “Normalizer View” on
page 7-14.

This section describes how you can use CAGE to space the breakpoints over the
range of the normalizers.

Normalizer Toolbar

B

1. Initialize 2. Fill 3. Optimize

To space the breakpoints, either click the buttons on the toolbar or select from
the following options on the Normalizer menu:

¢ Initialize
This spaces the breakpoints evenly along the normalizer. For more
information, see “Initializing Breakpoints” on page 7-5.

e Fill
This spaces the breakpoints by reference to the model. For example, you can
place more breakpoints where the model curvature is greatest. For more
information, see “Filling Breakpoints” on page 7-6.

* Optimize
This moves the breakpoints to minimize the least square error over the range

of the axis. For more information, see “Optimizing Breakpoints” on
page 7-10.

The next sections describe each of these in detail.
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Initializing Breakpoints
Initializing the breakpoints places the breakpoints at even intervals along the
range of the variable defined for the normalizer.

For example, a torque table has two normalizers, engine speed and relative air
charge, or load. You can evenly space the breakpoints of both normalizers over
the range 500 rpm to 6500 rpm for speed and 0.1 to 1 for the relative air charge.

To space the breakpoints evenly:
1 Click [l on the toolbar or select Normalizer —> Initialize.
2 In the dialog box, enter the range of values for the normalizer.

In the preceding example, for the speed normalizer, N, enter 500 6500, and
for the load normalizer, L, enter 0.1 1.

3 Click OK.

Note If the selected table has two normalizers, both are evenly spaced
automatically.
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Filling Breakpoints

Filling breakpoints spaces the breakpoints in such a way as to place the
breakpoints by reference to the model. For example, one method places the
majority of the breakpoints where the curvature of the model is greatest.

This option is only available when you are performing Feature calibrations.

For example, a model of the spark angle that produces the maximum brake
torque (MBT) has the following inputs: engine speed, N, relative air charge, L,
and air-fuel ratio, A. You can space the breakpoints for engine speed and
relative air charge over the range of these variables by referring to the model.

To space the breakpoints based on model curvature:
1 Click & or select Normalizer —> Fill.

The Breakpoint Fill Options dialog box opens.

+) Breakpoint Fill Options =10l =]

I;FiIIB P_Table_ML
Fill methad: I SharedwveCury ¥ I
Range L: IW
Range H: IW
&

|:F! arge: I 1117

Mumber of points: |2—

ak. | Cancel |

2 Choose the appropriate method to space your breakpoints, from the
drop-down menu in the dialog box.

For the preceding example, select ShareAveCurv. For more information
about the methods for spacing the breakpoints, see “Filling Methods” on
page 7-7.
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3 Enter the ranges of the values for the normalizers.

In the preceding example, for Range N, enter 500 6500, and for Range L,
enter 0.1 1.

4 Enter the ranges of the other model variables.

CAGE spaces the breakpoints by reference to the model. It does this at
selected points of the other model variables. In the preceding example, enter
11 17 for the Range of A and enter 2 for the Number of points. This takes
two slices through the model at A =11 and A = 17. Each slice is a surface in
N and L. That is, MBT(N, L, 11) and MBT(N, L, 17).

CAGE computes the average value of these two surfaces to give an average
model, MBT yy(N, L).

5 Click OK.

Note If any of the breakpoints are locked, each group of unlocked
breakpoints is independently spaced according to the selected algorithm.

If you increase the number of slices through the model, you increase the
computing time required to calculate where to place the breakpoints.

Filling Methods

This section describes in detail the methods for spacing the breakpoints of your
normalizers in CAGE.

¢ For one-dimensional tables, the two fill methods are

= ReduceError
= ShareAveCurv

® For two-dimensional tables, the two fill methods are

= ShareAveCurv
= ShareCurvThenAve
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ReduceError
Spacing breakpoints using ReduceError uses a greedy algorithm:

1 CAGE locks two breakpoints at the extremities of the range of values.
2 Then CAGE interpolates the function between these two breakpoints.

3 CAGE calculates the maximum error between the model and the
interpolated function.

4 CAGE places a breakpoint where the error is maximum.
5 Steps 2, 3, and 4 repeat.

6 The algorithm ends when CAGE locates all the breakpoints.

ShareAveCurv and ShareCurvThenAve

Consider calibrating the normalizers for speed, N, and relative air-charge, L,
in the preceding MBT model.

In both cases, CAGE approximates the MBT zy(IN, L) model, in this case, using
a fine mesh.

The breakpoints of each normalizer are calibrated in turn. In this example,
these routines calibrate the normalizer in N first.

Spacing breakpoints using ShareAveCurv or ShareCurvThenAve calculates the
curvature, K, of the model MBT ,y(N, L)

fine mesh
. 1/2
K = Z (MBT,v"(N, L))
1=1
as an approximation for
6000
K= " |MBT,,, L)|"%daN
750

Both routines calculate the curvature for a number of slices of the model at
various values of L. For example, the figure shown has a number of slices of a
model at various values of L.
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Model Slices at Various Values of L

Then
® ShareAveCurv averages the curvature over the range of N, then spaces the
breakpoints by placing the i*! breakpoint according to the following rule.

® ShareCurvThenAve places the ith breakpoint according to the rule, then finds
the average position of each breakpoint.

Rule for Placing Breakpoints. If j breakpoints need to be placed, the ith breakpoint,
N;, is placed where the average curvature so far is

N,
" 1/2 _1-1
j IMBT,y"(N.L)|""dN = := xK

750

Reference. de Boor, C., A Practical Guide to Splines, New York, Springer—
Verlag, 1978.

See Also

¢ “Calibrating the Normalizers” on page 7-4
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Optimizing Breakpoints
Optimizing breakpoints alters the position of the table normalizers so that the
total square error between the model and the table is reduced.

This routine improves the fit between your strategy and your model. The
following illustration shows how the optimization of breakpoint positions can
reduce the difference between the model and the table. The breakpoints are
moved to reduce the peak error between breakpoints. In CAGE this happens in
two dimensions across a table.

The green shaded areas show the error
= between the interpolated table values
S and the model using the initial
breakpoints.
Optimizing the position of the
2 breakpoints can greatly reduce the error
E between the interpolated table values
and the model.

Engine speed

To see the difference between optimizing breakpoints and optimizing table
values, compare with the illustration in “Optimizing Table Values” on
page 8-17.
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For an example of breakpoint optimization, say you have a model of the spark
angle that produces the MBT (maximum brake torque). The model has the
following inputs: engine speed, N, relative air charge, L, and air-fuel ratio, A.
You can optimize the breakpoints for N and L over the ranges of these
variables.

To optimize the breakpoints:

1 Ensure that the optimization routine works over reasonable values for the
table by choosing one of these methods:

a Select Normalizer —> Initialize.

b Select Normalizer —> Fill.
2 Click © on the toolbar or select Normalizer —> Optimize.

This opens the following dialog box.

<} Breakpoint Dptimization . 10| =l

EI:DptE P_Table_ML
BrL

—Hange: I nz 0aen
L—Mumber of points: I 36

E-N
—FRange: Iw
L—Mumber of pointg: IS‘B—
EHA

—FRange: 143

L—Mumber of pointg: I 1

\Reorder Deleted Breakpoints |

ak. Cancel
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3 Enter the ranges for the normalizers.

For the preceding example, enter 0.2 0.811 for the Range of L, and enter
750 6500 for N.

4 Enter the appropriate number of grid points for the optimization.

This defines a grid over which the optimization works. In the preceding
example, the number of grid points is 36 for both L and N. This mesh is
combined using cubic splines to approximate the model.

5 Enter ranges and numbers of points for the other model variables.

In the preceding example, the Range of A is 14.3 and the Number of points
is 1.

6 Decide whether or not to reorder deleted breakpoints, by clicking the radio
button.

If you choose to reorder deleted breakpoints, the optimization process might
redistribute them between other nondeleted breakpoints (if they are more
useful in a different position).

For information about deleting breakpoints, see “Deleting Breakpoints” on
page 7-20.

7 Click OK.

CAGE calculates the table filled with the mesh at the current breakpoints.
Then CAGE calculates the total square error between the table values and the
mesh model.

The breakpoints are adjusted until this error is minimized, using nonlinear
least squares optimization (1sqnonlin).

When optimizing the breakpoints, it is worth noting the following:

® The default range for the normalizer variable is the range of the variable.
¢ The default value for all other model variables is the set point of the variable.

® The default number of grid points is three times the number of breakpoints.
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See Also

® See the 1sqnonlin reference page.

e “Calibrating the Normalizers” on page 7-4
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Normalizer View

The normalizer node shows the Normalizer view, which displays

¢ One normalizer if the table selected is one dimensional

¢ Both normalizers if the table is two dimensional

The table in the following example is two dimensional.
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Normalizer View

Normalizer View

Selected node

1. Input output display

2. Normalizer display 3. Breakpoint spacing display

Feature | FM_N |
A& Branch 1 Inut Dutaut Mermalizer Display Breakpojnt Spacing
E-¥3 Torque L e
-l T1 1000 0 = 0 T
T 1333 1 .
4 FN_Loar 1887 2 5 75
B T2 2000 3 :
T4 ParR 2333 4 : 70
g4 13 2667 5 :
il FN_SPK anan G B85
3333 7 :
3667 B j £0
4000 9 i) 7
4333 10 i : -
4667 1 2000 4000 5000 2000 4000 5000
5000 12 | = 5 -
Fr_LOAD
Input Output Breakpoirt Spacing
0200 0
0.255 1
0309 2
0364 3
0418 4
04382 T
0.636 g
0691 q
0.745 10
n.aon 11
0.2 0.4 0.6 os
‘ _’I loze]

T4. To view the comparison pane
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Note Ifthe table has two normalizers, both are displayed. The normalizer for
the table columns at the top, the normalizer for the table rows below. This is
true whichever normalizer on the tree is highlighted.

The parts of the display are

1 The Input Output display shows the breakpoints of the normalizer. For
information, see “Input/Output Display” on page 7-16.

2 The Normalizer Display is a graphical representation of the Input Output
display. For information, see “Normalizer Display” on page 7-18.

3 The Breakpoint Spacing display shows a slice of the model over the range
of the breakpoints. For information, see “Breakpoint Spacing Display and
Deleting Breakpoints” on page 7-19.

4 The comparison pane. For information, see “Viewing the Comparison Pane”
on page 7-22.

The following sections describe in detail each part of the Normalizer view.

Input/Output Display

Input Output
500 1]

1055
1609
2164
2718
3273
3828
4332
4836
5391
5805
Aa00

=g == R R R =R R et

- =

The table consists of the breakpoints of the normalizer function.

The table has inputs and outputs:
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¢ The inputs are the values of the breakpoints.
® The outputs refer to the row/column indices of the attached table.

To change values of the normalizers using the Input Output display,
double-click a cell in the Input column and change its value.

Viewing the History of a Normalizer
To view the history of the normalizer function:

1 Right-click the table.

2 Select Show History from the menu.

This opens the History dialog box. For a more detailed description of the
History dialog box, see “Using the History Display” on page 13-5.

Locking and Unlocking Breakpoints in the Input/Output Display

Locking breakpoints ensures that the locked breakpoint does not alter its
position. You might want to lock a breakpoint when you are satisfied that it has
the correct value.

To lock a breakpoint in the Input/Output display:
1 Right-click the selected breakpoint.

2 Select Lock/Unlock from the menu.

Locked breakpoints have red cells.

To unlock cells follow the same procedure.

See Also

¢ “Normalizer View” on page 7-14
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Normalizer Display

This displays the values of the breakpoints plotted against the marker
numbers of the table (that is, the inputs against the outputs).

Click and drag the breakpoints to move them.

Example of the Normalizer Display

Marmalizer Display
Values of the D

breakpoint labels. 10 ----- ----- : /5.7/—0 :
Bt e
A locked S
breakpoint B
p j/g _____ s
Breakpoint ol i
AR :
~

02 04 06 058 1

0
J )
Values of the breakpoints

Locking and Unlocking Breakpoints in the Normalizer Display

To lock a breakpoint in the Normalizer Display, right-click the selected
breakpoint and select Lock Breakpoint. You might want to lock a breakpoint
when you are satisfied that it has the correct value.

Locked breakpoints are colored black.

See Also

¢ “Normalizer View” on page 7-14
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Breakpoint Spacing Display and Deleting
Breakpoints
The Breakpoint Spacing display shows

¢ A slice through the model in blue
® The breakpoints in red

To move breakpoints, click and drag.

Example of the Breakpoint Spacing Display

Breakpoirt Spacing

52 Asslice through the model: blue
=T
50

43
45
44

42 5
40
8 \ | Locked breakpoint: black

0 200N 4000 GO0
M
Deleted breakpoint: green

Breakpoints: red
—

Locking Breakpoints in the Breakpoint Spacing Display

You might want to lock a breakpoint when you are satisfied with its value.

To lock a breakpoint in the Breakpoint Spacing display, right-click a
breakpoint and select Lock Breakpoint from the menu.

Locked breakpoints are colored black.
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Deleting Breakpoints

Deleting breakpoints removes them from the normalizer table. There are still
table values for the deleted breakpoints: CAGE determines the positions of the
deleted breakpoints by spacing them linearly by interpolation between the
nondeleted breakpoints.

Deleting breakpoints frees ECU memory. For example, a speed normalizer
runs from 500 to 5500 rpm. Six breakpoints are spaced evenly over the range
of speed, that is, at 500, 1500, 2500, 3500, 4500, and 5500 rpm. If you delete all
the breakpoints except the endpoints, 500 and 5500 rpm, you reduce the
amount stored in the ECU memory. The ECU calculates where to place the
breakpoints by linearly spacing the breakpoints between the 500 rpm
breakpoint and the 5500 rpm breakpoint.

To delete a breakpoint, right-click the breakpoint and select Delete
Breakpoint.

Deleted breakpoints are green in the Breakpoint Spacing display.

Show the Model’s Curvature

You might want to view the curvature of the model to manually move
breakpoints to where the model’s curvature is greatest.

To display the model slice as its second-order derivative, the curvature of the
model:

1 Right-click the model in the Breakpoint Spacing display.

2 Select Display —> Model Curvature.

You can revert to displaying the model by selecting Display —> Model from the
right-click menu.
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Multiple Slice View
By default the Breakpoint Spacing display shows one slice through the model.

Slice Through a Model
Surface

Viewing many slices of the model gives a better impression of the curvature of
the model. For example, see the following figure.

Many Slices Through a Model
Surface

To view multiple slices through the model:
1 Right-click the model slice in the Breakpoint Spacing display.

2 From the menu, select Number of Lines and choose the number of slices
that you want to view from the list.
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See Also

¢ “Normalizer View” on page 7-14

Viewing the Comparison Pane

To view the comparison pane, select View —> Comparison. Alternatively,
click iwe: «, the “snapper point” at the bottom of the normalizer display panes.
This is labeled in the diagram of the “Normalizer View” on page 7-14.

Common Y ariables: d sl ey
001483
L rmn:l 01 max:| 1 pts:l 20 Mean Square |
L min] 500 maw B500  ptef 20 5 4678005
todel W ariables: Total Square E
A e 002195
1. The ranges of the 2. Variables in the model, 3. Number of points in the 4. Comparison of the grid 5. Error between the
variables common to not in the table comparison display and the model table and the model

the table and model

The comparison pane displays a comparison between the following:

¢ A full factorial grid filled using these breakpoints
® The model

Note This is not a comparison between the current table values and the
model. To compare the current table values and the model, see “Calibrating
the Tables” on page 8-12.

To make full use of the comparison pane:



Normalizer View

1 Adjust the ranges of the variables that are common to the model and table.

2 Adjust the values selected for any variables in the model that are not in the
selected table.

The default for this is the set point of the variable, as specified in the
variable dictionary. For more information, see “Using Set Points in the
Variable Dictionary” on page 6-10.

3 Check the number of points at which the display is calculated.
4 Check the comparison between the table and the model.
Right-click the comparison graph to view the error display.

5 Check some of the error statistics for the comparison, and use the
comparison to locate where improvements can be made.

Error Display

The comparison pane can also be used to display the error between the model
and the strategy.

Error Display in the
Comparison Pane

i - e
D.Dz_.......é.
0015 - % e
0o

0.00s 4§

mE

To display the error:
1 Right-click the axes of the comparison display.

2 Select Error from the menu.
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This changes the graph to display the error between the model and the
strategy.

You can display the error data in one of the following ways:

¢ Error. This is the difference between the feature and the model.

¢ Squared Error. This is the error squared.

¢ Absolute Error. This is the absolute value of the error.

¢ Relative Error (%). This is the error as a percentage of the value of the

model.
¢ Absolute Relative Error (%). This the absolute value of the relative error.

To select one of these displays of the error data:
1 Right-click the display.

2 Select Error Display and select the appropriate display of the error from the
context menu.

See Also

¢ “Normalizer View” on page 7-14

¢ “Comparing the Strategy and the Model” on page 8-35
This describes the comparison made when a table node is selected in the
branch display.
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A Feature calibration is the process of calibrating lookup tables and their
normalizers by comparing a Simulink strategy to a model.

The Simulink strategy is an algebraic collection of lookup tables. It is used to
estimate signals in the engine that cannot be measured and that are important
for engine control.

CAGE calibrates an electronic control unit (ECU) subsystem by directly
comparing it with a plant model of the same feature.

There are advantages to feature calibration compared with simply calibrating
using experimental data. Data is noisy (that is, there is measurement error)
and this can be smoothed by modeling; also models can make predictions for
areas where you have no data. This means you can calibrate more accurately
while reducing the time and effort required for gathering experimental data.

This discussion includes the following major topics:

¢ “Performing Feature Calibrations” on page 8-3
¢ “Setting Up a Feature Calibration” on page 8-5
e “Calibrating the Tables” on page 8-12

¢ “Table View” on page 8-30

¢ “Calibrating the Feature Node” on page 8-38

¢ “Feature View” on page 8-45

See “Feature Calibration Tutorial” on page 2-1 for a tutorial showing how to
perform a simple feature calibration.
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Performing Feature Calibrations

The basic procedure for performing feature calibrations is as follows:

Set up the variables and constants. (See “Setting Up Your Variable Items”
on page 6-7.)

Set up the model or models. (See “Setting Up Your Models” on page 6-14.)

Set up the feature calibration. (See “Setting Up a Feature Calibration” on
page 8-5.)

Calibrate the normalizers. (See “Calibrating the Normalizers” on page 7-4.)
Calibrate the tables. (See “Calibrating the Tables” on page 8-12.)

Calibrate and view the entire feature. (See “Calibrating the Feature Node”
on page 8-38.)

Export the normalizers, tables, and features. (See “Exporting Calibrations”
on page 6-22.)
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3. Set up the feature calibration.
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The normalizers, tables, and features form a hierarchy of nodes, each with its
own view and toolbar.
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Setting Up a Feature Calibration

A feature calibration is the process of calibrating lookup tables and their
normalizers by comparing a collection of lookup tables to a model. The
collection of lookup tables is determined by a strategy.

A feature refers to the object that contains the model and the collection of
lookup tables. For example, a simple feature for calibrating the lookup tables
for the maximum brake torque (MBT) consists of
* A model of MBT
® A strategy that adds the two following tables:

= A speed (N), load (L) table

= A table to account for the behavior of the air-fuel ratio (A)

Having already set up your variable items and models, you can follow the
procedure below to set up your feature calibration:

1 Add a feature. This is described in the next section, “Adding a Feature” on
page 8-5.

2 Assign a model. This is described in “Assigning a Model” on page 8-6.

3 Set up your strategy. This is described in “Setting Up Your Strategy” on
page 8-6.

4 Set up the tables. This is described later, in “Setting Up Tables” on
page 11-3.

This section describes steps 1, 2, and 3 in turn.

When you have completed these four steps, you are ready to calibrate the
normalizers, tables, and features.

Adding a Feature

A feature consists of a model and a collection of lookup tables, organized in a
strategy.

To add a feature to your session, select File -> New —> Feature. This
automatically switches you to the Feature view and adds an empty feature to
your session.
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An incomplete feature is a feature that does not contain both an assigned model
and a strategy. If a feature is incomplete, it is displayed as 2. in the branch
display. If a feature is complete, it is displayed as ¥ in the branch display.

Assigning a Model

Having already added a feature and a model to your session, you can assign a
model to your feature.

To assign a model to your feature:
1 Highlight the Feature node in the branch display.
2 Click Select Model to select the model you want to work with.
If there is only one model in your project, it is selected automatically.

If there is more than one model in your project, a dialog box appears.
Highlight the correct model to assign to your feature and click OK.

Setting Up Your Strategy

A strategy is an algebraic collection of tables, and forms the structure of the
feature.

For example, a simple strategy to calibrate a feature for MBT adds two tables:

¢ A table ranging over the variables speed and relative air charge
¢ A table to account for the behavior of the model as the AFR varies

To evaluate the feature side by side with the model, you need to have a strategy
that takes some or all of the same variables as the model.

The strategy is expressed using Simulink diagrams.

You can either import a strategy or you can construct a strategy.
The following topics are described next:

¢ “Importing a Strategy” on page 8-7

¢ “Constructing a Strategy” on page 8-8

¢ “Exporting Strategies” on page 8-10

* “Finding Blocks in Simulink” on page 8-11
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Importing a Strategy
To import a Simulink strategy:

1 Highlight the Feature in the branch display.
2 Select File —> Import —> Strategy.

3 Select the appropriate .md1 file. CAGE checks the strategy for more than
one outport.

4 Select the outport that you want to use.

If there is more than one outport to your strategy, a Simulink window opens.
Double-click the correct blue outport to parse (or import) the strategy to your
feature.

If there is only one outport to your strategy, a dialog box opens:
a Select Automatic to parse the strategy without viewing it.
Or

b Select Manual to edit the strategy. Double-click the blue outport circle to
parse the strategy to your feature.

Note When you double-click the blue outport, the Simulink windows shut
and parse this strategy to your feature.

To view a representation of your strategy, select the Feature node. Your
strategy is represented in the Strategy pane.

For information about using Simulink to amend strategies, see “Constructing
a Strategy” on page 8-8.

Example. In the matlab\toolbox\mbc\mbctraining directory, there is a
Simulink diagram called tutorial.mdl. If you import this and select Manual
in the dialog box, you see the following diagram.
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Double-click the Torque-Output outport to parse the strategy into the
Strategy pane.

Constructing a Strategy

For you to perform a feature calibration, the strategy and the model must have
some variables in common.

To construct a strategy using Simulink:
1 Highlight the correct feature by clicking the Feature node.
2 Select Feature —> Graphical Strategy Editor or press Ctrl+E.

Three Simulink windows open:

= The strategy window for editing your strategy
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Example of a Strategy Window
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= A library window with all the existing blocks in your session, organized in
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3 Inthe strategy window, build your strategy using the blocks available in the
library windows.

4 Double-click the blue outport circle to parse the strategy into the CAGE
session.

Note This closes all three Simulink windows and parses your strategy into
the feature.

For more information about using Simulink to build your strategy, see
Simulink Help.

Exporting Strategies
Simulink strategies can be exported. For example, you might want to

¢ Include a strategy in a Simulink vehicle model
¢ Evaluate the strategy using Real-Time Workshop® to produce C code
¢ Evaluate the strategy using Simulink

To export a strategy from CAGE:
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1 Highlight the Feature node that contains the strategy that you want to
save.

2 Select File —> Export —> Strategy.

3 Assign a name for your strategy.
The strategy is saved as a Simulink model (.md1) file.

Finding Blocks in Simulink
To find blocks in Simulink, highlight a Simulink window and press Ctrl+F or
select Edit —> Find.

This opens the Find dialog box, which helps find the blocks associated with
your feature.

I
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For more information about finding blocks, see Simulink Finder Help.
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Calibrating the Tables

8-12

After you set up your session and your tables, you can calibrate your tables.

Highlight a table in the branch display to view the Table view. For more
information about the Table view, see “Table View” on page 8-30.

In CAGE, a table is defined to be either a one-dimensional or a two-dimensional
lookup table. One-dimensional tables are sometimes known as characteristic
lines or functions. Two-dimensional tables are also known as characteristic
maps or tables.

Each lookup table has either one or two axes associated with it. These axes are
normalizers. See “Normalizers” on page 7-1 for more information.

For example, a simple MBT feature has two tables:

* A two-dimensional table with speed and relative air charge as its normalizer
inputs

¢ A one-dimensional table with AFR as its normalizer input

Before you can calibrate your tables, you must calibrate your normalizers. For
information, see “Calibrating the Normalizers” on page 7-4.

This section describes how you can use CAGE to fill your lookup tables by
reference to a model.

Table Node Toolbar

1. Initialize —\ 5. Fill by

e F Inversion
2. Fill J T l\— 4. Extrapolate

3. Optimize

To fill the table values, either click the buttons in the toolbar or select from the
following options in the Table menu:
¢ Initialize
Sets each cell in the lookup table to a specified value. For information, see
“Initializing Table Values” on page 8-13.



Calibrating the Tables

* Fill
Fills the table values by reference to the model. For information, see “Filling
Table Values” on page 8-14.

¢ Optimize
Fills the table values by minimizing the total square error between the table
values and the model. For information, see “Optimizing Table Values” on
page 8-17.

¢ Extrapolate
Fills the table values based on the cells specified in the extrapolation mask.
You can choose values in cells that you trust to define the extrapolation mask
and fill the rest of the table using only those cells for extrapolation. For
information, see “Filling the Table by Extrapolation” on page 8-20.

¢ Fill by Inversion
Fills the table by creating an inversion of another table. For information, see
“Inverting a Table” on page 8-22.

The next sections describe each of these in detail.

Initializing Table Values

Initializing table values sets the value of every cell in the selected table to a
constant.

To initialize the values of the table:
1 Click E or select Table —> Initialize.

2 In the dialog box that appears, select the constant value that you want to
insert into each cell.

When initializing tables, you should think about your strategy. Filling with
zeros can cause a problem for some strategies using “modifier” tables. For
example, your strategy might use several speed-load tables for different values
of AFR, or you might use an AFR table as a “modifier” to add to a single
speed-load table to adjust for the effects of different AFR levels on your torque
output.

If your table is a modifier that is added to other tables, you should initially fill
it with Os; if it is a modifier that multiplies other tables, you should fill it with
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1s. If you do not, when CAGE tries to fill the table by rearranging the strategy
equation (model = table * modifier table), there is a problem, as you cannot
divide by zero. This operation will fail.

See “How CAGE Fills Tables” on page 8-14.

Filling Table Values

This tool fills the table with the values of the model at the operating points
specified in your normalizers.

To fill the table values by reference to the model:
¢ Click & or select Table —> Fill.

How CAGE Fills Tables

CAGE fills tables in a feature calibration by rearranging the equation
model = strategy.

Example
A very simple example strategy for torque might consist of two tables:

® A speed-load (or relative air-charge) table filled with values of torque
® An air-fuel ratio (AFR) modifier table to account for the behavior of AFR

8-14
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~
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Model (Speed, Load, AFR) —  p-Torque } Model

This example is a strategy with a base speed-load (N, L) table for torque and a
modifier table to account for the behavior of AFR (A). Your strategy might use
several speed-load tables for different values of AFR, or as in this case you
might use an AFR table as a modifier to add to a single speed-load table to
adjust for the effects of different AFR levels on your torque output.

T1(N,L) + T2(A) = Model(N, L, AFR) -
With the tables arranged in the following manner, this is the feature equation:
Model = T1 + T2
To fill the speed-load table, the equation is rearranged to
T1 = Model -T2
If the AFR modifier table (T2) is initialized with Os, this becomes
T1 = Model -0 or
T1 = Model

Each cell in the table is therefore filled with the corresponding values of the
model at the operating point specified by the breakpoints.
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For example, to fill the T1 cell (Speed = 2500, Load = 0.5), CAGE evaluates the
model at Speed = 2500, Load = 0.5, and uses the value of AFR that you choose
in the dialog that appears.

You can choose one value of AFR for the whole table (for example, 14.3), or you
can choose a range of values and fill using the average model value at each cell.
For example, if you choose AFR =11, 13, 15, the model is evaluated at all three
values for each cell and the average model value is used. The default AFR value
is the set point (which you can set in the variable dictionary).

Note To fill using model values averaged over a range of an input variable,
you type the minimum and maximum (separated by a space) in the Range
edit box, and the number of desired points in the Points edit box.

When the base table (T1) is filled, CAGE rearranges the equation again to fill
the modifier table (T2):

T2(A) = Model(N,L,A) - T1(N,L)

For example, to fill the T2 cell at AFR = 12.5, you choose values of speed and
load (such as 3000,0.4) and CAGE evaluates the following:

T2(12.5) = Model(3000, 0.4, 12.5) - T1(3000, 0.4)

As before, you can choose a range of values for speed and load and use the
average to fill the table.

Note Be careful not to initialize modifier tables with 0 if they are multipliers
in your strategy. In this case, solving Model = T1 x T2 for T1 gives
T1=Model/T2, and you cannot divide by zero. This operation will fail.

Solving Model = Strategy algebraically for a table in the strategy is not always
possible. In these cases you must use optimization.
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Optimizing Table Values

Optimizing the table values minimizes the current total square error between
the table values and the model.

This routine improves the fit between your strategy and your model. Using Fill
places model values directly into your table; whereas the optimization process
can shift those values up and down to give the least overall error between the
interpolation between table values and the model surface. You should use Fill
first to place model values into your table — this gives the optimization routine
a good starting point.

This process is illustrated by the following example; the green shaded areas
show the error between the mesh model (evaluated at the number of grid points
you choose) and the table values.

® This shows the error when filling the
g table using model values.
S

This shows the reduced error after
“2_’_ optimizing table values.
2

Engine Speed

To see the difference between optimizing table values and optimizing the
positions of breakpoints, compare with the illustration in “Optimizing
Breakpoints” on page 7-10.
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For an example of optimizing table values, say you have a model of the spark
angle that produces the maximum brake torque (MBT). The model has inputs
engine speed, N, relative air charge, L, and air-fuel ratio, A. The strategy that
you are using to calibrate the MBT feature has an N-L table and a table to
account for the variation of MBT over the range of A.

To optimize the table values:

1 Ensure that the optimization routine works over a reasonable range of
values by selecting Table —> Fill.

Optimization works best if you start with a sensible range of values. Using
Fill places model values at the appropriate operating points into each cell of
the table. From this point, the optimization routine has the best chance of
finding a good solution quickly.

For example, a model for MBT might have a range of values from 20 degrees
to 35 degrees. Running the optimization routine when most of the cell values
are outside this range (say if your table is filled with 0s), is very time
consuming.

2 Click @ or select Table —> Optimize.

This opens the following dialog box.
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Enter the ranges for the normalizers.

For the preceding example, enter 0.2 0.811 for the range of L. and enter
750 6500 for N.

Enter the number of grid points for the optimization.

This defines a grid over which the optimization works. Above, the number of
grid points is 36 for both L and N. This mesh is used to approximate the
model. The default number of grid points is three times the number of
breakpoints in the table.

Enter the ranges and numbers of points for the other model variables.

In the preceding example, the range of A is 14.3 and the Number of points
is 1. The mesh approximates the value of the model at only one value of A.

Click OK.

CAGE evaluates the model over the number of grid points specified, then
calculates the total square error between this mesh model and the table values.
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CAGE adjusts the table values until this error is minimized, using 1sgnonlin.

When optimizing the table values, it is worth noting the following:

® The default range for a normalizer variable is the range of the variable.

¢ The default value for all other model variables is the set point of the
variable’s range.

® The default number of grid points is three times the number of breakpoints.

¢ Increasing the number of grid points increases the quality of the
approximation, but also the computation time.

See Also

® See the 1sqnonlin reference page.
e “Calibrating the Tables” on page 8-12

Filling the Table by Extrapolation

Filling a table by extrapolation fills the table with values based on the values
already placed in the extrapolation mask. The extrapolation mask is described
below.

To fill a table by extrapolating over a preselected mask, click ™ or select Table
—> Extrapolate.

This extrapolation does one of the following:
¢ Ifthe extrapolation mask has only one value, all the cell values change to the
value of the cell in the mask.

¢ If the extrapolation mask has two or more collinear values, the cell values
change to create a plane parallel to the line of values in the mask.

¢ Ifthe extrapolation mask has three or more coplanar values, the cell values
change to create that plane.

e If the extrapolation mask has four or more ordered cells (in a grid), the
extrapolation routine fills the cells by a grid extrapolation.

¢ If the extrapolation mask has four or more unordered (scattered) cells, the
extrapolation routine fills the cell values using a thin plate spline interpolant
(a type of radial basis function).
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Using the Extrapolation Mask

The extrapolation mask defines a set of cells that form the basis of any
extrapolation.

For example, a speed-load (or relative air-charge) table has values in the
following ranges that you consider to be accurate:

® Speed 3000 to 5000 rpm
® Load 0.4 to 0.6

You can define an extrapolation mask to include all the cells in these ranges.
You can then fill the rest of your table based on these values.

To add or remove a cell from the extrapolation mask:
1 Right-click the table

2 Select Add to/Remove from Mask from the menu.

Cells included in the extrapolation mask are colored yellow.

Cells that are locked and in the extrapolation mask are colored green.

Generating the Extrapolation Mask from the Predicted Error

Predicted error (PE) is the standard deviation of the error between the model
and the data used to create the model. You can automatically generate an
extrapolation mask based on the predicted error.

To generate a mask automatically:

1 Right-click the Menu button of the table and select Generate
Extrapolation Mask from Predicted Error.

2 In the dialog box, set the PE threshold. Click OK.

The cells in the table where the predicted error is within the threshold now
form the extrapolation mask, and thus are colored yellow.
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Inverting a Table

You can use CAGE to produce a table that is the inverse of another table. This
involves swapping a table input with a table output, and you can invert 1-D or
2-D tables.

Torque Load

- .
Load Torque

Inverting a table allows you to link a forward strategy to a backward strategy;
that is, swapping inputs and outputs. This process is desirable when you have
a “forward” strategy, for example predicting torque as a function of speed and
load, and you want to reverse this relationship in a “backward strategy” to find
out what value of load would give a particular torque at a certain speed.

Normally you fill tables in CAGE by comparing with data or models. Ideally

you want to fill using the correct strategy, but that might not be possible to find
or measure. If you only have a forward strategy but want a backward one, you
can fill using the forward strategy (tables or model) and then invert the table.

For example, in order to fill a table normally from a model, you need the model
response to be the table output, and the model inputs to be a function of the
table inputs (or it should be possible to derive the input — for example, air
mass from manifold pressure). If the available model is “inverted” (the model
response is a table input and the table output is a model input) and you cannot
change the model, you can invert the table in CAGE.
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Torque Spark
Load Load
\Spurk \Torque
Model Table to fill

In the diagram of a table shown, the x- and y-axes represent the normalizers
(which you want to be spark and load) and the z-axis is the output at each
breakpoint (torque). To fill this table correctly from the model is a two-step
process. First you need to fill a table that has the same input and output as the
model, and then fill a second table by inversion.

For the inversion to be deterministic and accurate, the table to be inverted
must be monotonic; that is, always increasing or decreasing. This requirement
is explained by the following one-dimensional example. Every point on the
y-axis must correspond to a unique point on the x-axis. The same problem
applies also to two-dimensional tables: for any given output in the first table
there must be a unique input condition; that is, every point on the z-axis should
correspond to a unique point in the x-y plane. Some table inversions have
multiple values and so do not meet this requirement, just as the square root
function can take either positive or negative values. You can use the inversion
wizard in CAGE to handle this problem; you can control the inversion process
and determine what to do in these cases.
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Load

Torque )

L
Torque

Load
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Torque

The preceding example illustrates a table with multiple values. There are two
solutions for a single value of torque. CAGE has a table inversion wizard that
can help overcome this problem. You can specify whether you want to use the
upper or lower values for filling certain parts of the the table; this allows you
to successfully invert a multiple-valued function. See the inversion
instructions for 1-D and 2-D tables in the next sections.

The process of inverting a one-dimensional table is different from the process
of inverting a two-dimensional table.
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Inverting One-Dimensional Tables

To invert a one-dimensional table:

1 Ensure that your session contains two tables:

a The first table from your forward strategy, filled
b The second table from your backward strategy, which you want to fill

2 Highlight the second table.
3 Click F or select Table —> Inversion.
The lower pane now acts as a wizard.
4 In the lower pane, highlight the table that you want to invert.

5 Click Next. The next page asks what CAGE should do if it encounters
multiple values. The options are

= Maximum selects the uppermost range if a given number has two possible
inverses (like selecting the positive square root of a number).

= Minimum selects the lower of the two if a given number has two possible
inverses (like selecting the negative square root of a number).

= Intermediate selects the middle range if a given number has more than
two possible inverses.

= Automatic selects the range that produces the least error (see below; the
last page of the wizard plots the error metric).

For example, the function y = x2 is impossible to invert over the range -1 to

1. You can specify to invert the range from 0 to 1, sacrificing the inversion in
the lower range, or the reverse. To select the range from 0 to 1, highlight
Maximum.

The display shows a comparison between the table (green) and the function

x = £H(Ax).
6 Highlight the part of the table to invert, then click Next.

The last page of the wizard has a comparison plot that shows how successful
the inversion has been. If your forward function is y = f(x), and your inverse
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function is x = g(y), then, combining these, in an ideal world, you should have
x = g(f(x)). The plot then displays a red line showing x against x and a green
line showing x against g(f(x)). The closeness of these two lines indicates how
good the inversion has been: a perfect inverse would show the lines exactly
on top of each other. In the following example, the lines are together and
then diverge; this plot can show you which part of your table has not
successfully inverted and where you should try a different routine.

Inverting a
One-Dimensional Table

Plot of A against tself (red), and & plot of 4 against r”(r’(,q)) (green).

mb- .......... .......... . .......... ......

et | Firizh Cahicel

Note The automatic inversion routine tries to minimize the total distance
between these lines. This can sometimes lead to unexpected results. For
example, given the function f(x) = x*2 between —1 and 1, if you select either
positive or negative square root as the inverse, this induces a large error in
the combined inverse. If you choose g(y) = sqrt(y), then g(f(-1)) = 1, an error of
2. To minimize this, the automatic routine might choose to send everything to
zero and accept a medium error over the whole range rather than a large error
over half the range. The more knowledge you have of the form of the “forward”
table will help you make an informed choice about which routine to select.

7 Click Finish to accept the inversion or Cancel to ignore the result and
return to the original table.
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Inverting Two-Dimensional Tables
To invert a two-dimensional table:

Ensure that your session contains two tables:

a The first table from your forward strategy, filled
b The second table from your backward strategy, which you want to fill
Highlight the second table.

Click F or select Table —> Inversion.

The lower pane now acts as a wizard.

In the lower pane, highlight the table that you want to invert.
Click Next.

Identify the corresponding signals.

The forward table and backward table share a common input. This page of
the wizard lists all possible combinations of inputs into the forward and
backward tables and asks you to highlight the combination that gives the
two common inputs. To illustrate this, if the forward table gives torque in
terms of the variables engine speed and load, whereas you want the
backward table to give load in terms of RPM and Tq, then the list would read

RPM and engine speed
RPM and load

Tq and engine speed
Tq and load

In this case, you would select the first option.
Highlight the part of the table to invert, then click Next.

CAGE asks what to do if it encounters multiple values. The choices are

= Maximum selects the uppermost range (like choosing a positive square
root of a number).
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= Minimum selects the lower value if there are two choices (like choosing a
negative square root of a number).

= Intermediate selects the middle range when there are more than two
choices.

= Automatic selects the range that produces the least error. CAGE tries to
choose values to put in the inverse table that minimize an error metric
similar to the error metric for 1-D tables (see “Inverting One-Dimensional
Tables” on page 8-25).

Choose one of these options and click Next.

The last page of the wizard has a comparison plot that shows how successful
the inversion has been. If the forward function is z = f(x,y), and the inverse
function is x = g(y,z), then, combining these, in an ideal world you should
have x = g(y,f(x,y)). The plot then displays a plane showing x plotted against
x and y, and a colored surface showing g(y,f(x,y)) plotted against x and y. The
closeness of these two planes indicates how good the inversion is. Following
is an example. In this case, the forward table is a quadratic (z = y*2); the
backward table is inverted using the positive square root of z (maximum
range). As you can see, this leads to large errors at negative values of y, but
good inversion for positive values of y.
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1 Plot of v against tself (blue), and a plot of v against F’(x,f(x,y)) (colored).

¥
Iext | Finigh | Cancel |

9 Click Finish to accept the result or Cancel to ignore the result and return
to the original table.
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Table View

When you select a table in the branch tree (in feature or manual calibration),
you see the Table view. In CAGE, a table is defined to be either a
one-dimensional or a two-dimensional lookup table. One-dimensional tables
are sometimes known as characteristic lines or functions. Two-dimensional
tables are also known as characteristic maps or tables. CAGE regards them
both as similar objects.

Each lookup table has either one or two axes associated with it. These axes are
normalizers.

For example, a simple MBT feature has two tables:

¢ A two-dimensional table with speed and relative air charge as its
normalizers

¢ A one-dimensional table with AFR as its normalizer

For feature calibration (filling the tables by comparing a strategy and a model),
see “Calibrating the Tables” on page 8-12.

For an example of manual calibration (filling tables using experimental data),
see “Filling Tables from Data Tutorial” on page 5-1.

The example following is a feature view. In manual calibration, you do not see
the comparison pane because you are not comparing tables with a model.
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Table Display in Feature Calibration

Selected node 1. Table 2. Graph of the table
|

Feature | 0.20 0.24 0.29 0
A Brandh 1 750.00 35714 22628 18.712 17.
¥ Mew_Feature 1156.60 4,226 30692 27.289 24,
- Table HL 1621.20 8.013 35.408 31.868 28,
|l NomL | 214390 8.327 35.995 32706 29,
ot Mo M| 313130 35611 32.957 30.279 27,
B Frd 2654.00 37.104 14,525 31876 29,
vl Mom A | 9381 00 44358 41.574 38.645 35,
493180 45.449 42.952 40.255 a7
5861.10 40.024 36.680 37.129 35,
£500.00 37.393 36.996 36.423 35,
R i

T ahle variables =] Marirmum error.

The parts of the display are numbered and labeled as follows:

L: Mir| 0.2 Max| 0,811 F'ts:|2EI
M: Mir:| 750 Max:| 6500 F'ts:|2EI
kodel variables

A 14.3

El |5—

30
a0 ).
6000

4000 .
ﬁDDD

3. Comparison of results

[.7E56

Mean square ermor:

0.05351

Total square emor;
21.4

1 The table pane displays the breakpoints of the normalizer and the values of
the table. (See “Viewing a Table” on page 8-32.)
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2 The graph of the table pane displays the table values graphically. (See
“Using the Graph of the Table” on page 8-34.)

3 The comparison-of-results pane displays a comparison between the current
output of the strategy and the feature model. (See “Comparing the Strategy
and the Model” on page 8-35.)

Note You can view the History display by selecting View —> History. For
information, see “Using the History Display” on page 13-5.

This section describes each of these parts in detail.

Viewing a Table

The table displays the values of your lookup table and displays the breakpoints
of the normalizers. For example, the following table shows a lookup table with
speed and relative air-charge (load) as its normalizers.

— 0.10 0.20 o230 | .
Menu button /] 500.00 -3.201 8.078 18,181 (e”'"'he_
99935 2,448 5.7568 19.907 extrapolation mask
1501.00 | -2.023 8.218 20251
201170 | -1.824 5.403 20542
240080 | -1.895 8.236 20473
3000.20 5.991 20128
Locked cell in as00.70/] 2827 £.403 18541
extrapolation mask—|_+000.20 -3.703 7520 | IIECKIEE— Selected cell
450150 | -4.818 B.412 17 &850
500010 | -5.204 16.163
540050 | -7.862 2.280 14512
539930 | -8.745 1461 12611
6500.00 | -11.961 -0.579 TI333 Locked cell
A i

To edit a value in the table, double-click the cell. Selected cells are light blue
(or pink if they are locked or in the extrapolation mask).
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Locking and Unlocking Cell Values

When you are satisfied with a region of the table, you might want to lock the
cell values in that region, to ensure that those values do not change.

To lock or unlock a cell value, right-click the cell and select Lock/Unlock from
the menu.

Locked cells are colored red in the display (they turn pink when selected).

Menu Button Options
Right-clicking the menu button in the top left corner of the table gives you the
following options:

¢ Lock/unlock entire table. This toggles between the table’s being locked or
unlocked.

® Generate Extrapolation mask from predicted error. See “Generating the
Extrapolation Mask from the Predicted Error” on page 8-21.

¢ Clear extrapolation mask. This ensures that none of the cells are in the
extrapolation mask.

Properties

The table properties enable you to specify the precision type of the table data.

You can choose from

® Floating-point precision

¢ Polynomial ratio, fixed-point precision

® Lookup table, fixed-point precision

To display the properties of the table, select Table —> Properties.
This opens the Table Properties dialog box.

Table properties are discussed in detail in “Table Properties” on page 11-7.
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Using the Graph of the Table

The table view displays both the table values and a graph of the table. This
gives a useful display of the table’s behavior. Shown is an example of a graph.

&t
40
304

)

1000 T

2000

WoS000 T 03

L

Line indicates which value in the table you are editing.

® You can rotate the graph of the table by clicking and dragging the axes.

® You can alter values in the table by clicking and dragging vertically any
point.

® When you click a point, a blue line indicates the selected point in the table.
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Comparing the Strategy and the Model

When you calibrate a strategy, or collection of tables, by reference to a model,
it is useful to compare the strategy and the model. The following pane
illustrates a comparison.

/3. Number of points in the comparison display

Table Variables: [~ Msimum Error
- 33.25
N minf 995 mawe| 5006 ptf|20 Mean Squars Ertor
inc| 01907 max: I 0.E46 phs I 20 27849
kodel ¥ ariables: Tlotal Square Eror
A [1031 1/116e+005
D
SPE. I a1
1. The ranges of the 2. Variables in the model, 4. Comparison of the 5. Error between the
common variables not in the table strategy and the model strategy and the model

Note This is a comparison between the current strategy values and the
model, unlike the comparison pane from the normalizer node, which compares
the model and a full factorial grid filled using the breakpoints.

To make full use of the comparison of results pane:

1 Check the ranges of the variables that are common to the model and table.
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2 Check the values selected for any variables in the model that are not in the
selected table. The default for this is the set point of the variable’s range.

3 Check the number of points at which the display is calculated.

4 Check the comparison between the table and the model. You can rotate this
comparison by clicking and dragging, so that you can view all parts of the
comparison easily.

5 Check some of the error statistics for the comparison.
You can also view the error over the range of the feature.

Error Display

The comparison-of-results pane can also be used to display the error between
the model and the strategy.

P emcar SRR
goz 4.
ooms MR &

om

0005 4--§°

e

To display the error:
1 Right-click the axes of the comparison display.

2 Select Error from the menu.

This changes the graph to display the error between the model and the
strategy.

You can display the error data in one of the following ways:

¢ Error. This is the difference between the feature and the model.

¢ Squared Error. This is the error squared.
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¢ Absolute Error. This is the absolute value of the error.
¢ Relative Error (%). This is the error as a percentage of the value of the

model.
* Absolute Relative Error (%). This the absolute value of the relative error.

To select one of these displays of the error data:

1 Right-click the display.
Select Error Display and select the appropriate display of the error from the
context menu.
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Calibrating the Feature Node

8-38

Selecting a Feature node displays the Feature view. For more information
about the Feature view, see “Feature View” on page 8-45.

The Feature view enables you to calibrate the entire feature. Calibrating the
feature means that you fill the breakpoints in the normalizer, and the table
values, by referring to a model.

Feature Node Toolbar

KH;& .
1. Initialize 3. Optimize

2. Fill

To calibrate the feature, either click the buttons on the toolbar or select from
the following options on the Feature menu described in these sections:

1 “Initializing the Feature” on page 8-38
2 “Filling the Feature” on page 8-40

3 “Optimizing the Feature” on page 8-42

Initializing the Feature

For example, a simple feature for maximum brake torque (MBT) consists of the
following tables:

¢ A speed (), load (L) table
® A table to account for the behavior of air-fuel ratio (A)

Initializing this feature sets the values of the normalizers for speed, load, and
AFR over the range of each variable and put specified values into each cell of
the two tables.

A table that is already initialized provides a useful starting point for a more
detailed calibration.

To initialize the feature:
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1 Click E . This opens the Feature Initialization Options dialog box, as

shown.

<) Feature Initialization OpEion

H—]—Breakpoints of Marm_L
I—Breakpoint range:
[=-Breakpaints of Narm_M
I—Breakpoint range:

'—Enahle

=% alues of Table ML

—Initial vwalue:

—E nahble

[=-Breakpaints of Fr_a

H—]—Breakpoints of Marm_g,
I—Breakpoint range:

'—Enahle

=% alues of Fri_a

—Initial vwalue:

—E nahble

(]9

=0l x|

E;Inilialize MHew Featurs

H—]—Breakpoints of Table_ML

I 02 081
I 750 6500

i
ID
i

1 176

i
ID
i

| Cancel |

2 Enter the ranges for the breakpoints in your normalizers. In the preceding

example, enter the following breakpoint ranges:

= L hasrange 0.2 0.811.
= N has range 750 6500.

= Aha

srange 11 17.6.

3 Enter the initial table value for each cell in each table. Above, enter the cell

values

as

= Table_NL has initial value 0.
= Fn_A has initial value 0.
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4 (Click OK.

Note The default values in this dialog box are taken from the variable
dictionary. If you clear any Enable box, the associated table or normalizer is
left unchanged.

Filling the Feature

A very quick way to calibrate a feature is to fill it. This does two things:

¢ CAGE spaces the breakpoints of the normalizers by reference to the model.
For example, the breakpoints can be spaced to place most breakpoints where
the curvature of the model is greatest. This process is described in detail in
“Filling Breakpoints” on page 7-6.

¢ Then CAGE fills the tables by reference to the model. This process is
described in detail in “Filling Table Values” on page 8-14.

This section describes the procedure to fill a feature. For a detailed description
about the filling processes, see the sections listed above.

To fill a feature:

1 Click £ . This opens the Feature Filling Options dialog box, shown.
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<} Feature Filling Options ; 10l =l
Fill Mew_Feature ;I
B-Breakpaints of Table_NL Method for filling the

_ _ normalizers of Table_NL
H—]—FHI Breakpaoints

—Fill method: IShare.-’-‘weCuw
—Range L: [0z s Range of L
—HRange N: I TR0 6R00

- Range of N

Range: 14.3 1
. The value of A used to calculate the
MHumber of points: I 1

model when filling the normalizers
—Enable ol of Table_NL

[#-0ptimize Breakpoints

=% alues of Table ML

B

Range: 14.3
Nurber of pointe: I \The value of A used to evaluate the
HITREr B AT model when filling the table
—Enable v Table_NL
[=-Breakpaints of Fr_a

-Fill Breakpoirts Expand this node to view the

i . settings for filling the normalizer
[#-0ptimize Breakpoints of Fn A

=" alues of Fri_a
Bl Expand these nodes to view the
settings for filling the table Fn_A

[+-MN
—E nable i

LT able fill order: | [121] r Table fill order

QK. | Cancel |

2 Select the correct method for filling your normalizers.
3 Enter the ranges for the normalizers of the tables.

4 Enter the ranges of the other variables when filling the normalizers.
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5 Enter the ranges of the other variables when filling the tables.
6 Enter the table fill order.

In this example, enter [1 2 1]. This fills the normalizers and then fills the
table values of Table_NL. Then CAGE fills the normalizers, and then the
table values of table Fn_A. After which CAGE then fills the normalizers and
then the table values for Table_NL again.

7 Click OK.

You can iterate this process using the table fill order edit box, as in the
example. This further improves the fit of the strategy and the model.

Note Feature fill gives you the choice of optimizing each normalizer before
filling the table values. To do this, expand the Optimize Breakpoints node
and select the Enable box. If you clear any Enable box, that table is not filled.

When you have completed a calibration, you can export your feature. For
information, see “Exporting Calibrations” on page 6-22.

Optimizing the Feature

After filling the feature, you can improve the fit of the strategy to the model by
optimizing the feature. The optimization routine does the following:

¢ First CAGE optimizes the breakpoints for the normalizers. (See “Optimizing
Breakpoints” on page 7-10.)

® Next CAGE optimizes the values of the tables. (See “Optimizing Table
Values” on page 8-17.)

This section gives the procedure for optimizing a feature. For further details of
how optimization works, see the references given above.

To optimize a feature:

1 Click © . This opens the Feature Optimizing Options dialog box, as
shown.
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<} Feature Optimization Opktions i
E]:Dplimize MHew Featurs

LJ—]—B reakpoints in Table_ ML

H

R ange:

“—Murmnber of points:

R ange:

“—Murmnber of points:

R ange:

“—Murmnber of points:

‘—Enahle

= alues of Table ML

R ange:

“—Murmnber of points:

R ange:

“—Murmnber of points:

R ange:

“—Murmnber of points:

‘—Enahle

=0l x|

—Reorder Deleted Breakpoints

el
. —

I 750 500 i
I 36 I

ID.2 0811 —
ISE —

I 750 500 —
I 36 —

Options for Optimizing Normalizers of Table_NL
Range of normalizer L

Number of grid points for normalizer L

Range of normalizer N

7

| Number of grid points for normalizer N

1 The value of A used to evaluate the model when
optimizing the normalizers of Table_NL

Options for Optimizing Table Values of Table_NL

Range and number of grid points for normalizer L, used for
7 optimizing Table_NL

Range and number of grid points for normalizer N, used for
7 optimizing Table_NL

The value of A used to evaluate the model when optimizing
Table_NL

/

Options for Optimizing the Normalizers and Table Fn_A

t-Breakpoints in Fr_a,
-4 alues of Fr_a&

Expand these nodes to view the settings for optimizing the

T able optimization arder:

Cahicel |

normalizers and table Fn_A.

\ Table fill order
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2 Enter the ranges of the normalizers for the normalizer optimization.
3 Enter the numbers of grid points for the normalizers.

4 Enter the values for the other variables.

5 Enter the ranges of the normalizers for the table optimization.

6 Enter the numbers of grid points for the normalizers.

7 Enter the values of the other variables.

8 Enter the table fill order.

In this example, enter [1 2 1]. This optimizes the normalizers and then the
table values of Table_NL. Next CAGE optimizes the normalizers, and then
the table values of table Fn_A. After which CAGE optimizes the normalizers
and then the table values for Table NL again.

9 Click OK.

Note You can iterate this process using the table fill order edit box, as in the
example. This further improves the fit of the strategy and the model.

When you have completed a calibration, you can export your feature. For
information, see “Exporting Calibrations” on page 6-22.
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Feature View

As you select a Feature node you see the Feature view, shown. This section
describes the Feature view and the Feature menu options.

Selected feature

1.

The strategy for the selected feature 2. The model associated with the selected
feature
|

Featlre

/_3' Branch 1

Mew Feature

Ei@. T

| = Feature Hiztary

Strategy: Klnputs: N.L.A,SPK

[T aorm_M(MLMHom_LL]) + F_AMNorm_A[S]] + F_SRKIMom_SPESPR])

Modek b, Inputs N L .4 SPK /

Select Model... | Dezelect Model |

Comment / Action | Add
Strategy equation diagram created and parsed

Remove

i

l | j

Details:

3. Feature History pane
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The parts of the Feature view include

1 The strategy for the selected feature. This is the algebraic collection of the
tables that you are using to calibrate the selected feature.

2 The model associated with the selected feature.

3 The Feature History pane, which displays the history of the feature.

Feature Menu
The Feature menu has the following options:

® Select Model

Use this to select the correct model for your feature.
® Deselect Model

Use this to clear the current model from your feature.
® Convert Feature to a Model

Takes the current feature and converts it to a model, which you can view by
clicking the Model button.

¢ Clear Current Strategy
Clears the current strategy from your feature.
¢ Graphical Strategy Editor

Opens your current strategy for editing. For more information, see “Setting
Up Your Strategy” on page 8-6.

¢ Parse Strategy Diagram

Performs the same function as double-clicking the blue outport of your
strategy diagram. For more information, see “Setting Up Your Strategy” on
page 8-6.
Enables you to view the feature and the model using the surface viewer. For
information, see “Surface Viewer” on page 12-1.

¢ Initialize
Initializes the feature; also in toolbar. See “Initializing the Feature” on
page 8-38 for details.
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e Fill
Fills the feature; also in toolbar. See “Filling the Feature” on page 8-40 for
details.

¢ Optimize
Optimizes the feature; also in toolbar. See “Optimizing the Feature” on
page 8-42 for details.
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Tradeoff

A tradeoff calibration is the process of calibrating lookup tables by adjusting
the control variables to result in table values that achieve some desired aim.

For example, you might want to set the spark angle and the air-fuel ratio (AFR)
to achieve the following objectives:

¢ Maximize torque

¢ Restricting CO emissions

The data in tradeoff is presented in such a way as to aid the calibrator in

making the correct choices. For example, sometimes the model is such that only
a slight reduction in torque results in a dramatic reduction in CO emissions.

This section on tradeoff calibrations includes the following:

¢ “Performing a Tradeoff Calibration” on page 9-3 for an overview of the
tradeoff process

¢ “Setting Up a Tradeoff Calibration” on page 9-5

e “Calibrating Tables in a Tradeoff Calibration” on page 9-9

¢ “Using Regions” on page 9-15

¢ “Multimodel Tradeoffs” on page 9-17

See Also

¢ “What Is a Tradeoff Calibration?” on page 3-3
This is a tutorial giving an example of how to complete a tradeoff calibration.
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Performing a Tradeoff Calibration

The basic procedure for performing tradeoff calibrations is as follows:

Set up the variables and constants. (See “Setting Up Your Variable Items”
on page 6-7.)

Set up the model or models. (See “Setting Up Your Models” on page 6-14.)

Set up the tradeoff calibration. (See “Setting Up a Tradeoff Calibration” on
page 9-5.)

Calibrate the normalizers. (See “Calibrating the Normalizers” on page 7-4.)

Calibrate the tables. (See “Calibrating Tables in a Tradeoff Calibration” on
page 9-9.)

Export the normalizers, tables, and tradeoffs. (See “Exporting Calibrations”
on page 6-22.)

You can also use regions to enhance your calibration. (See “Using Regions” on
page 9-15.)
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94

6. Export the
calibration.

5. Calibrate the
tables.

4. (alibrate the
normalizers.

1. Set up the
variables.

2. Set up the
models.

-} CAGE Browser - tradeoffready.cag

3. Set up the tradeoff calibration.

=10l x|

——File Edit Tradeoff Tools ‘Window Help
D" X F%|? &
Froceszes Tradeoff | Tables
A Branch 1
528 New_Tradeoff -
- 4 Sour Tabje | |AFR_Table
= pare_table | JEGA_Table

[ ata Objects

o Speed
|/ Load

-, 1% AFR_Table
o Speed
el Load

-l EGR_Tabls

~| Spesd

~.| Load

Spark_Table fill by: SPK.
Diizplay Options
Available models: Current display:

The normalizers, tables, and tradeoff form a hierarchy of nodes, each with its
own view and toolbar.
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Setting Up a Tradeoff Calibration

A tradeoff calibration is the process of filling lookup tables by balancing
different objectives.

Typically there are many different and conflicting objectives. For example, a
calibrator might want to maximize torque while restricting nitrogen oxides
(NOx) emissions. It is not possible to achieve maximum torque and minimum
NOx together, but it is possible to trade off a slight reduction in torque for a
reduction of NOx emissions. Thus, a calibrator chooses the values of the input
variables that produce this slight loss in torque instead of the values that
produce the maximum value of torque.

A tradeoff also refers to the object that contains the models and tables. Thus, a
simple tradeoff can involve balancing the torque output while restricting NOx
emissions.

After you set up your variable items and models, you can follow the procedure
below to set up your tradeoff calibration:

1 Add a tradeoff. This is described in the next section, “Adding a Tradeoff” on
page 9-5.

2 Add tables to the tradeoff. This is described in “Adding Tables to a Tradeoff”
on page 9-6.

3 Display the models. This is described in “Displaying Models in Tradeoff” on
page 9-7.

This section describes steps 1, 2, and 3 in turn.

When you finish these steps, you are ready to calibrate the normalizers and
tables.

Adding a Tradeoff

To add a tradeoff to your session, select File -> New —> Tradeoff. This
automatically switches you to the Tradeoff view and adds an empty tradeoff to
your session.



9 Tradeoff Calibrations

9-6

An incomplete tradeoff is a tradeoff that does not contain any tables. If a
tradeoff is incomplete, it is displayed as 55 in the branch display. If a tradeoff
is complete, it is displayed as z= in the branch display.

After you add a tradeoff you must add tables to your tradeoff.

Adding Tables to a Tradeoff
1 Add a table by selecting Tradeoff —> Add Table.

Note that you must select the top tradeoff branch in the tree display to use
the Tradeoff menu. This is automatically selected if your tradeoff has no
tables yet (it is the only branch). You must also add at least three variables
(in the variable dictionary) to your project before you can add a table,
because CAGE needs a variable to fill the table and two more variables to
define each of the two normalizers.

A dialog box opens.

-} Add Table to Tradeoff x|

) Add evisting table

| i

' Create a new table

Table name: I

Mormalizers

® name; I Size:
W name: I Size:

I Fed with: |>< 'I
I Fed with: IY 'I

Fill this table with: |2 [~

Ok | Cancel Help

2 Either select a current table from your CAGE session to calibrate, using the

top list box, or create a new table. You can add existing tables in the session;
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you can choose them from the drop-down list as long as they are not empty
(that is, they must be initialized tables that have values and defined sizes).

To create a new table:

a Enter the name for the table.

b Enter names for each of the normalizers.

¢ Enter sizes for each of the normalizers.

d Select the input for each of the normalizers.

e Select the variable or model you want to fill the table with.
3 Click OK.

CAGE adds a table node to the tree.

4 Repeat this procedure for each new table you want to add.

Note Each additional table must have the same normalizers as the first
table, so you do not have to perform steps b ¢ and drepeatedly.

Displaying Models in Tradeoff
To display models when viewing tables in the tradeoff display:

1 Highlight the tradeoff node.

2 From the Available Models, select the one you want to display.
Models that are referenced by tables are automatically displayed.

3 Click ﬂ to move the selected model into the Current Display pane.

4 Repeat steps 2 and 3 until you have displayed all the models that you want
to work with.
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— Display Optionz
Ayailable Models Current Display

Modell SPE, L. N, A, E] ;I

MWOXFLOW _Modell SPK, L. N, A, E)

Deselecting a Model.
1 In the Current Display, select the model that you want to remove.
2 Click _<| to move the selected model into the Available Models pane.

3 Repeat until you have cleared all the appropriate models.

Once you have displayed all the models that you want to work with, you are
ready to calibrate your normalizers and tables.
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Calibrating Tables in a Tradeoff Calibration

Selecting a table node in the branch tree display enables you to view the models
that you have displayed and calibrate that table.

To calibrate the tables:

2

Select the table that you want to calibrate.

Highlight one operating point from the table.

Set the values for other input variables.

For information, see “Setting Values of Other Variables” on page 9-11.
Determine the value of the desired operating point.

For information, see “Determining a Value at a Specific Operating Point” on
page 9-13.

Click ﬂ to apply this value to the lookup table.

This automatically adds the point to the extrapolation mask.
Repeat steps 2, 3, 4, and 5 at various operating points.
Extrapolate to fill the table by clicking ® .

For information, see “Filling the Table by Extrapolation” on page 8-20.

After you complete all these steps you can export your calibration. For
information, see “Exporting Calibrations” on page 6-22.
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Table View in a Tradeoff Calibration

1, Select the table.

that you want to calibrate.

2. Select the operating point inthe table 6. Repeat this process over a number

of operating points in the table.

9-10

Tradealf | Spark: N = 2000. L = 0.7. Cell filled with SPK.
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28 New_Tradeof 1500.0p0 | zo00.000 | (35 e
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4. Determine a suitable value for the point.

3. Set the values for other input variables.
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Notice that the graphs colored green indicate how the highlighted table will be
filled:

¢ If a row of graphs is highlighted, the table is being filled by the indicated
model evaluation (the value shown at the right of the row).

¢ If the column of graphs is green, the table is being filled by the indicated
input variable (shown in the edit box above the column).

The next sections describe the following in detail:

® “Setting Values of Other Variables” on page 9-11
¢ “Determining a Value at a Specific Operating Point” on page 9-13

Setting Values of Other Variables

Typically the models that you use to perform a tradeoff calibration have many
inputs. When calibrating a table of just one input, you need to set values for the
other inputs.

Graphs in Table View
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Setting Values for Individual Operating Points
To set values for inputs at individual operating points:

1 Highlight the operating point in the lookup table.

2 Use the edit boxes to specify the values of the other variables.

In the preceding example, the spark table is selected (the SPK graph is colored
green). You have to specify the values of AFR (A) and EGR (E) to be used:

1 Select the spark table from the branch menu.
2 Click in the edit box for A and set its value to 14.3.

3 Click in the edit box for E and set its value to 0.

Setting Values for All Operating Points

For example, if you are using a tradeoff to calibrate a table for spark angle, you
might want to set the initial values for tables of air-fuel ratio (AFR) and
exhaust gas recycling (EGR).

To set constant values for all the operating points of one table:
1 Highlight the table in the branch display.
2 Select one operating point in the table.
3 Enter the value of the cell.
This automatically adds this cell to the extrapolation mask.

4 Click E to extrapolate over the entire table.

This fills the table with the value of the one cell.
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Determining a Value at a Specific Operating Point

Edit box displaying the
value of SPK

—

Behavior of TQ_Model

99% confidence limits for
TQ_Model

Value of

T _Model

{ 382232

spark

MORFLOWY hodel

Value of the TQ_ Model
Ll (found at the upper right
corner of the pane)

Value of the NOXFLOW Model
240.5661 — (found at the upper right corner
of the pane)

Performing a tradeoff calibration necessarily involves the comparison of two or

more models.

For example, in this case, the calibrator uses his or her judgment to select a
value of spark that gives acceptable values for both the torque and the NOx

flow models.

To select a value of spark, do one of the following:

® Click the edit box as shown above and enter the required value.

® Drag the red line.

Once you determine the value of your variable at this operating point, you
apply this value to the table by pressing Ctrl+T, by selecting Table —> Apply
Point, or by clicking #|(Add Point) in the toolbar.
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Right-Click Menu
Right-clicking a graph enables you to

¢ Find Nearest Turning Point
¢ Find Global Maximum
¢ Find Global Minimum

Using Zoom Controls on the Graphs

To zoom in on a particular region, click with both mouse buttons
simultaneously and define the region as a rectangle.

To zoom out to the original graph, double-click the selected graph.

Note Zooming on one graph adjusts other graphs to the same scale.

View Options
Selecting the View menu offers you the following options:

* History

This opens the History display. For information, see “Using the History
Display” on page 13-5.
¢ Show/Hide Factors

This opens a dialog box that allows you to show or hide factors. This is
particularly useful if you are trading off models that have a large number of
factors.

e Show/Hide Models

This opens a dialog box that allows you to show or hide models. This is
particularly useful if you are trading off a large number of models.

¢ Show Predicted Error

When you select this, the graphs display the 99% confidence limits for the
models.

¢ Same Y Limits On Graphs

When you select this, all the graphs share a common y-axis.
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Using Regions

A region is an area that defines locally where to extrapolate before globally
extrapolating over the entire table.

For example, consider filling a large table that has twenty breakpoints for each
normalizer, by extrapolation. Two problems arise:

¢ To have meaningful results, you need to set values at a large number of
operating points.

® To set values at a large number of operating points takes a long time.

To overcome this problem, you can
1 Define regions within the lookup table.
2 In each region, set the values of some operating points.

3 Click E to fill the table by extrapolation.

Each region is filled by extrapolation in turn. Then the rest of the table is filled
by extrapolation. The advantage of using regions is that you can have more
meaningful results by setting values for a smaller number of operating points.

Tradeoff Table
500.000 | 1000.000 | 1500000 | 2000.000 | 2500.000

0.100 72.028 29.094 32.197 32.967 32.383
0.200 10.040 18.056 24.116 27.388
0.300 -0.000 10.517

0.400 0.640 10.256 18.444

0.500 1.731 8.761 13.162 13.511 11.641
0.600 0.891 7.895 7.963 6.423
0.700 5.857 5.548
0.800 0.128 5.809 7.606 8.958
0.800 0.964 4.447 7.609 10.517 13.283
1.000 1.929 5.630 9.156 12.488 15.546

| | ol

Cells are colored

¢ Yellow if they form part of the extrapolation mask

® Blue if they are part of a region
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¢ Gold if they are part of the extrapolation mask and part of a region

Defining a Region

1 Highlight the rectangle of cells in your table.
2 Click F&| to define the region.

The cells in the region are colored blue.
Clearing a Region

1 Highlight the rectangle of cells in your table.

2 Click F | to clear the region.
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Multimodel Tradeoffs

There are two types of tradeoff that you can add to your session, a tradeoff of
independent models, as described earlier (see “Performing a Tradeoff
Calibration” on page 9-3), or a tradeoff of interconnected models (a multimodel
tradeoff).

A multimodel tradeoff is a specially built collection of models from the Model
Browser.

You can build a series of models so that each operating point has a model
associated with it. In the Model Browser, you can export models for a
multimodel tradeoff from the test plan node. The models must be two-stage and
must have exactly two global inputs.

The procedure for calibrating by using a multimodel tradeoff follows:

1 Add the multimodel tradeoff. (See the following section, “Adding a
Multimodel Tradeoff” on page 9-18.)

2 Calibrate the tables. (See “Calibrating Using a Multimodel Tradeoff” on
page 9-20.)

3 Export your calibration. (See “Exporting Calibrations” on page 6-22.)

When you calibrate the tables in a multimodel tradeoff, you can only adjust a
value in the tables if there is a model defined at this operating point. These
cells are colored purple in the table. At each of these operating points, you have
a model that you use to trade off, and by doing this you can adjust the value in
the table. All other cells in the table do not have models associated with them
and you cannot edit them (but they can be filled by extrapolation). You trade off
values at each of the model operating points in exactly the same way as when
using independent models, as described in “Determining a Value at a Specific
Operating Point” on page 9-13. When you have determined table values at each
of the model operating points, you can fill the whole table by extrapolation by
clicking ™ . See “Filling the Table by Extrapolation” on page 8-20.
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Adding a Multimodel Tradeoff

To add a multimodel tradeoff to your session:

1 Select File -=> New —> Multimodel Tradeoff. The file must have been
exported from the MBC Model Browser using the Tradeoff button (only
enabled for two-stage models with exactly two global inputs).

2 Select the correct file to import and click Open. This opens a dialog box.

<} Multimodel Tradeoff Creation : x|
— Dperating points — Current location get
Factor 1 Factor 2 Include 55
amon | 280 W =
a0 [oRR ]
002000 | 32020 W
000483 [ 3950 W s
1997.000 | &0020 W 40 o o o
- o
35 ©
Reset Values | o)
30 o] o
o
— Awailable models a5 o) o
v - o
@l i 20 o] o
¥ HCEMISS 5 o
W NOEMISS B, ©
¥ 5007 10 : : :
- 1000 2000 3000 4000
ak. | Cancel |

3 In the Operating points pane, you can clear the check boxes for any
operating points that you do not want to import.

Notice that the operating points are displayed graphically in the Current
location set pane. If an operating point is deselected, it is displayed as gray
here, rather than red.

CAGE creates tables for all the models and input variables, with
breakpoints at all the operating points.
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4 You can adjust any of the operating points to reduce the number of
breakpoints.

For example, in the session pictured, there are operating points at values of
2001, 2002, 2000.489, and 1997. This results in breakpoints in the table at
each of these four values. However, all four operating values are very close
to 2000 and might all have been intended to run at exactly 2000. You can
choose to adjust all these to 2000 by typing in the edit boxes. The table then
has a single breakpoint at 2000 instead of the four closely spaced
breakpoints. You can click Reset Values to return to the original operating
points.

5 In the Available models pane, clear any model that you do not want to
import.

For example, you might want to perform a tradeoff of soot (S00T) and torque
(TQ) in the preceding example. Clear the check boxes for HCEMISS and
NOEMISS.

6 Click OK.

When you import the multimodel tradeoff, you import the tables and
normalizers, so you do not have to calibrate the normalizers.

Note When you calibrate the tables, you can only adjust the values of the
tables at the operating points defined for the models. These are colored purple
in the table.

You can now calibrate your tables. See the next section, “Calibrating Using a
Multimodel Tradeoff” on page 9-20.

9-19



9 Tradeoff Calibrations

Calibrating Using a Multimodel Tradeoff

Each purple (editable) operating point in your tables has a model associated
with it. You use the display of these models to help you trade off values at these
points to fulfill your aims in exactly the same way as when using independent
models in “ordinary” tradeoff mode, as described in “Determining a Value at a
Specific Operating Point” on page 9-13.

1 Change input values by dragging the red lines on the graphs or by typing
directly into the edit boxes above the graphs.

2 Look at the model evaluation values (to the right of each row of graphs) and
the input variable values (in the edit boxes above the graphs) to see if they
meet your requirements.

Remember that the green highlighted graphs indicate how the selected table
is filled: if a row is green, the model evaluation value (to the right) fills the
table at that operating point; if a column is green, the input variable value
(in the edit box above) fills the table. See the example following; the SPK
column of graphs is green, so the value of SPK in the edit box is entered in
the table when you click the Add Point button ( ﬂ ).

This column is green, so this Value of the TQ model
value of SPK is entered in the
table.

14.2 u
LT | 17

sl e ' —
a0 - _\\' 23 k- - e
L i AN
- : : S : :
= L T e S
2 PGS B s Value of the
= of A . : NOXFLOW model
100 F__Jl/-' : '\t.\ j,...-_..,:_.:.:;.:..
B P PR 1 Ve
12 14 16 3 5 ‘0
200 p === : - - . -
= : : : 10}t A __\_,:____ 13l | 240.56€1
: N A Y N ;
2 1] S i i R o :
2 17 TS R T N g
- ' a -, . .
E o == e R e
(=] ' o . e L T—
= 1 I I Op=-p---- B} RRE ] T LLETET IR e
[TV S o A R A [ e i 1
o 2 = 12 14 16 a s -0
P & E

=

alue of spark
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3 When you are satisfied with the tradeoff given by the value of your variable
at this operating point, you apply this value to the table by pressing Ctrl+T,
selecting Table —> Apply Point, or clicking ﬂ in the toolbar.

4 When you have determined table values at each of the model operating
points, you can fill the whole table by extrapolation by clicking ™ . See
“Filling the Table by Extrapolation” on page 8-20.

You can then export your calibration; see “Exporting Calibrations” on
page 6-22.
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1 O Data Sets

The Data Set view has two main functions:

¢ Validating calibrations with experimental data

¢ Filling tables by reference to a set of experimental data
For worked examples about data sets, see

¢ “Data Sets Tutorial” on page 4-1
This shows the process of validating a calibration.
¢ “Filling Tables from Data Tutorial” on page 5-1

This shows the process of filling a table from experimental data.
This section describes in detail

¢ “Data Sets Views” on page 10-3

e “Setting Up Data Sets” on page 10-5

¢ “Viewing Data in a Table” on page 10-12

¢ “Plotting Outputs” on page 10-14

¢ “Using Color to Display Information” on page 10-17

¢ “Linking Factors in a Data Set” on page 10-21

¢ “Assigning Columns of Data” on page 10-23

¢ “Manipulating Models in Data Set View” on page 10-24
¢ “Filling Tables from Experimental Data” on page 10-25
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Data Sets Views

Data Sets consists of four views. These views display different aspects of the
data set. Each view is accessible from the View menu or by clicking the
appropriate button on the toolbar.

Factor Information

=+ i———Fill Table from Data Set

Plot Qutputs

View Data

¢ Factor Information

List of all available project expressions, which can be added to the data set
for display and evaluation.

® View Data

Displays the data in a table. Individual entries can be altered. Columns of
data can be assigned to CAGE expressions.

* Plot Outputs

Displays models and features evaluated at the data points (of the data set).
¢ Fill Table from Data Set

This mode allows you to fill tables by reference to experimental data.
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) CAGE Browser - datasettut.cag

File  Edit

View Data  Tools

‘Window  Help

=101 x|

D=EE|& x| |

M8 = &

Processes

Data Set

] New Dataset

[Data Set Factors

¥4 Tomque: Model T Output; Feature
ii.Torque: Strateqy TP Output: Feature

Factar | Status | Unilsl Infa
xXn E] Input

X load % Input

X afr E] Input

X zpk Input

] nmeas Output; Data

tgmeas Output: Data

Project Expressions

Ewpreszion | | it | Branch | Tupe | Info
X afr Wariable  In data zet
X load Yariable  In data get
Xn Wariable  In data zet
X szpk Yariable  In data et
11 Branch1 Table
/12 Branch1 Table
/13 Branch1 Table
4\ TORGUE Model
23. Torque: Maodel Branch 1 Feature  In data zet
¥y Torque: Strateqy Branch1 Feature  In data zet




Setting Up Data Sets

Setting Up Data Sets

The Data Sets view displays the strategies, tables, and models, etc., by default
as a list of factors in the Factor Information view. You can also display the
same factors as columns in a grid, with all factors displayed as columns in the
list, by selecting the View Data toolbar button ( [l ). The data set works over
a grid of values, which is not necessarily the same as the normalizers of any
included tables in the data set.

You have to set the input factors and their values to define the grid in the data
set. You can do this in one of three ways:

¢ Import experimental data. (See “Importing Experimental Data” on
page 10-5.)

¢ Import the values from a table in your CAGE session. (See “Importing Data
from a Table in Your Session” on page 10-7.)

® Specify the factors and their values manually. (See “Specifying the Factors
Manually” on page 10-8.)

The next sections describe each of these in detail.

Importing Experimental Data
You can import experimental data to a data set, either to validate a calibration
or to use it as the basis for a calibration.

You can import data that is stored in the following formats:

¢ Microsoft Excel spreadsheets
¢ Comma-separated value files
* MAT files

Importing from Excel or Comma-Separated Value. When you import data from either
a Microsoft Excel spreadsheet or from a comma-separated value file, you must
ensure that the data is organized in the following manner:

® The first column can either be row markers (text) or entries (numbers).

¢ The first row can either be column headers (text) or entries (numbers).

e All the other row and column entries must be numbers.
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Importing From MAT-files. When you import from a MAT-file, you must ensure
that the file contains numbers only, that is, a double-array.

To import experimental data:

1 Select File -> Import —> Data.

2 In the file browser, select the correct file to import.
This opens the Data Set Import Wizard.

3 Discard any columns of data you do not want to import by selecting the
column and clicking the button shown.

i
4 Click Next.

The following screen asks you to associate variables in your project with
data columns in the data.

5 Highlight the variable in the Project Assignments column and the
corresponding data column in the Data Column, then click the assign
button, shown.

ﬂ

6 Repeat step 5 until you are satisfied that you have associated all the
variables and data columns. Any unassigned data columns are treated as
output factors.
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-} Data Set Import Wizard o ]
— Match data columns inright ligt to project expressions in left izt
Mate: Unazzigned columns will be treated as output data
Project Azzignments D ata Columns
Froject | Data Column Hame | Colurmn
¥ oA X afrmeas 4
xL loadmeas X loadmeas 3
x N hmeas o X nhmeas 2
&« RPM 1
X spkmeas 5
x tqmeaz g
| i B l |
™ Show all expressions
ak. Cancel

Assign button

7 Click Finish to close the dialog box.

This imports your data into the data set. When you have imported your data,
you can view your data set.

Importing Data from a Table in Your Session
To import data from a table:

1 Select Data —> Import —> Import from Table.

If your data set is not empty, a dialog box asks whether you want to Fill the
data set from the table or Overwrite the data set from the table. Select Fill
to use the table values to fill the factors in your data set. Select Overwrite

10-7



1 0 Data Sets

10-8

to disregard all factors in your data set and fill the data set with the input
and output factors from the table. A dialog box opens.

2 Select the correct table from your session to import and click OK.

When you have imported your data, you are ready to view the data set.

Specifying the Factors Manually

1 Select the Data Set view by clicking the large Data Sets button in the Data
Objects pane.

2 Add a data set to the project by selecting File -> New —> Data Set.

3 Select the factors. (See “Selecting the Factors” on page 10-8.)

4 Build the grid. (See “Manually Setting Values of the Input Variables” on
page 10-10.)

Once you have completed these steps you can view the data set.
This section describes

¢ “Selecting the Factors” on page 10-8
¢ “Manually Setting Values of the Input Variables” on page 10-10

Selecting the Factors

Clicking the Factors View button in the toolbar (
boxes.

i ). This displays two list

¢ The upper list shows all factors within the data set. You can sort factors by
clicking the column headings.

¢ The lower list shows CAGE project expressions.



Setting Up Data Sets

Factors in the current dafa set

Data Sets

] MyDatal

Data Set Factors

Factor | Statug | Information |
X afr % Input

X load E, Input

Xn % Input

X spk E, It

fix)lambda It

E—)Torque_minus_quue Dutput: Data set Dutput Sum - TORGUE
ii.Torque: haodel TP Output: Feature

¥y Torque: Strateqy TP Output: Feature

Project Expressions

E sprezzion | Branch

| Tvpe

| |nformation

X afr Yariable  |n data set
fix) lambda " ariable In data zet
X load Yariable  |n data set
Xn " ariable In data zet
X spk Yariable  In data zet
BT Branch1  Table

{12 Branch1 Table

{13 Branch1  Table

4\ TORGUE Models

23. Torque: Maodel Branch 1 Feature Ih data zet

¥y Tlorque: Strateqy  Branch 1 Feature In data zet

Factors in the current project

You can use this view to add factors to or remove factors from the data set.

To add a factor to a data set:

1 Select the factor or factors that you want to add to the data set from the list
in the lower Project Expressions pane.

To make multiple selections, use the standard Shift+click or Ctrl+click.

2 Select Data —> Factors —> Add to Data Set. Alternatively, you can
right-click the factor and select Add to Data Set from the context menu.
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To remove a factor from a data set:

2

Select the factor or factors that you want to remove from the data set.

Select Remove from Data Set from the right-click menu.

Note Links between the two lists are always preserved, so clicking load in
the upper list also selects load in the lower list. In other words, you can copy or
remove from either list and the relevant results appear in both. Multiply
selecting in one list therefore deselects everything in the other list.

Manually Setting Values of the Input Variables

Clicking the Build Grid toolbar button ( Hs ) or selecting Data —> Build Grid
enables you to set the values of the input variables for the data set.

To build a full factorial grid:

2

Select Data —> Build Grid.
Select the factor that you want to define a grid for.
Set the grid for the factor.

To set a grid of 5, 10, 15, 20, 25, 30, input the following: 5:5:30, where the
first number is the minimum, the second is the step size, and the last
number is the maximum value.

Check the size of the data set in the pane. The current size reported at the
bottom of the dialog is the size if you click Cancel to leave the data set
unchanged. The projected size is created if you click OK. In the following
example, the projected size of 45 you can see is obtained by multiplying the
number of points for each factor with a grid (in this case, 3 * 5 * 3).

Select the next factor that you want to define a grid for.

When you have set the grids for all the factors, click OK.
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) Grid Data Set _|Ol| x|
Grid over data set input factors
Factar | Type | Range -
. . i“n Grid 936:1002:5004 (5 points)
1. Highlight the input factor. {/ load Grid 01:022054 (3 points)
= afr Congtant 14.3 -
i'_"{ zpk. Grid -8.1:23:49.9  [3 pointz) o
< I »
Enter range or constant for this wariable. Clear
Colon natation may be used to specify range [eg 0:5:20 = —I
05101520 Wake ﬁ«ctivel
2. Set the range for the factor. o __—|o1022084

Current size: 44 point(s). Projected size: 1980 oK | Cancel |

mminH =] |

3. (hleck the size of the data set.

Creating a Factor from the Error Between Factors

To create a factor that is the difference between two other factors:
1 Highlight the two factors, using Ctrl+click or Shift+click.

2 Select Create Error from the right-click menu on either column head.

This creates a new factor that is the difference between the two other factors.
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Viewing Data in a Table

Click the View Data button ( Ml ) in the toolbar or select View -> Data to
display the data in tabular form and a list of the current items in the project.

Note that this view is only enabled if you have a grid of points at which to
evaluate and display the models and variables. This grid is not necessarily
derived from the normalizers of any tables included in the data set. You can set
the grid by importing experimental or table data, or by using the Build Grid
toolbar button ( Hm ). See “Setting Up Data Sets” on page 10-5.

Inputs to the selected
column, colored yellow

Input that is not an input to
the selected column

Selected column

-

|

10-12

| I

I L A SPK | EGR | nmeas |igmeas Mewy_Feature: Strategy
1 2235100 | 0549 | 9545 (0038 0.000 |2247 200/ 66 .6E2 36,326 35.477
2 3591.000| 0.454 | 13,182 [0.069 | 0.000 |3613.200| 54,114 26.381 24 362
3 4346100 | 0,651 | 12.046 [ 0.083| 0.000 |4973.500) 73.700 34 406 42730
4 880.800 | 0.648 | 11.934 | 5719 | 0.000 | 8BO.570 | 75.764 8.109 a0.743
5 2234300 | 0,441 | 13.278 | 0.079| 0.000 |2246.900) 55882 30.038 24112
B 3590.700 | 0747 | 10.888 | 0.064 | 0.000 |3611.800) 89.983 45420 a6.68T
7 4946.500 | 0541 | 87145 |0119| 0.000 (4972700 62.753 200032 28.8649
8 880.800 | 0622 | 9.904 | 0.057| 0.000 | 884.230 | 72.084 47888 41.787
g 1218.700 | 0.333 | 14.017 | 0100| 0.000 |1224.400) 41.775 17776 11.358
10 1558.000 | 0.382 | 11.955 | 0.069| 0.000 |1567.200) 49.384 25.404 17.214
11 1895.600 | 0.209 | 10.680 | 3.288| 0.000 |1905.700) 28.509 5.919 0.296
12 2233800 | 0284 | 9805 |3159| 0.000 2245300 36.020 12.344 8.835
13 2574400 | 0,407 | 13.423 | 3.024| 0.000 |2588.000) 49.883 26.942 23.297
14 2913.900 | 0595 | 11.506 | 3.090| 0.000 |2929.400) 70537 46.414 43.871




Viewing Data in a Table

Columns are color coded by factor type:

¢ Input factors are colored white.
¢ Qutput factors are colored light blue.

Selecting an output column highlights the input columns associated with it by
turning the header cells yellow.

Standard editing facilities are available.
Double-click an input cell to edit the value.

Cut and paste use the desktop clipboard. Cells, columns, and rows can be
copied directly to and from other applications (for example, Excel).

Note You can only edit input values, not output values.
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Plotting Outputs

10-14

Use this to plot the outputs of your data sets.

To view a plot:

1 Select View —> Plot or click the ¥ toolbar button.
2 Select an expression from the list to view.
A plot of the selected output factor appears in the top pane.
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3 Use the pop-up menus below the plot to change the factors displayed.

To

zoom in on an area of interest:




Plotting Outputs

® Press both mouse buttons simultaneously and drag a rectangle; double-click
the graph to return to full size.

Plotting Multiple Selections
You can plot a multiple selection by using standard Ctrl+click and Shift+click

operations.
A legend at the top of the screen displays the key to the graph.

& Torque: Strateqy  #  tgmeas

Targue : Strategy, tameas v Data set point
L : * .

<Selection>

Data set point

w-axiz factor: IData set point vI y-awiz factor: |<Se|ectinn> vl
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 rmeas D ata set Output

&1 Branch 1 Table
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Multiple Plot Outputs
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When exactly two items are displayed, further plot options are available:

¢ Plot the first item against the second item (X-Y Selection).
¢ Display the error using one of the following options:

= Error

= Absolute error

= Relative error (%)

= Absolute relative error (%)
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Using Color to Display Information

You can use the plot view to display more information by coloring the plots.

Coloring a Plot
1 Select View —> Plot or click H

2 Highlight the correct expression in the Output Expressions (Project and
Data Set) pane.

3 Select Color by Value from the right-click menu of the plot.

4 Select from the pop-up menu the variable you want to use to color the plot.

10-17



1 0 Data Sets

1. Click Plot Outputs.
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Using Color to Display Information

In the following figure, you can see

¢ A plot of the Sum vs Data Set Point (this is the strategy from a torque
feature calibration).

® The points are colored by load.

¢ For this example it can be seen that in general, the higher the load, the
higher the value of torque.
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Restricting the Color

You might be interested in only part of the display; for example, you might only
be interested in points with a low engine speed. The various display options
enable you to color only the points that you are interested in.

To restrict the color:
1 Select the Limit range box.

2 Adjust the maximum, midpoint, and minimum of the range by dragging the
icons on the color bar.

3 Examine the data points and those that are outside the range.
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Use the right-click menu to alter the view of the points outside the range:

¢ Select Restrict Color to Limits to compress the colours in the colour bar
within the limit markers, as in the example shown. Points outside the limits
are still coloured, but only dark red or dark blue, depending on which end of
the range they are. This increases the range of colours over the range you are
interested in (between the limits), making it easier to see the distribution of
points.

¢ Select Exclude to remove all points outside the limits from the display.

¢ Select No Color Outside Limits to display the points as in the example
shown. Points outside the limits are plotted as empty circles.

¢ Select Color Outside Limits to display all points in colour, including those
outside the limits.
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Linking Factors in a Data Set

A factor can be linked to another. The factor then takes on the values of that
other factor, overwriting the original values.

For example, you might want to link a variable spark with a model for
maximum brake torque (MBT) to evaluate a torque model.

To link two factors:
1 Select Data —> Links. This opens a dialog box.
2 Select the data set factor that you want to overwrite.

CAGE generates a list of factors that you could possibly link to the selected
factor. (For example, you cannot link to a factor that depends on the selected
factor.)

3 Select the factor that you want to link the selected factor with.

4 Click = |to link the two factors.
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-} Link Data Set . =0l x|

— Select factor in left ligt and link, in right list,
Data Set Factors | Fossible Links
M arne | Linked | M ane | Type |A
XA XA ‘Yariable
i'_"{ afr_spark_rod i—fw afr_spark_nod Tahle
xL A Fa Tahle
x N AF T able
X SPK &= gpark_F... ¥y Fr_Featurs Feature
X % == P Model Madel
Xy xL Wariable
Xz A MBT_Modsl todel
F2 XM Yariable
T |¥%-spak_Featurs: Equation  Feature
¥y bpark_Feature; Madel Feature i
i& park_tahle Tahle
%7 able_HL T able
i& T able_yz Table
¥ Torque_Feature: Equation Feature
P21 [Termiie Fashiws hdadal  Fazhira j
QK. | Cancel |
2. Select the factor that 4. (lick here to link 3. Select the factor that you want
you want to overwrite. the factors. to link it with.

CAGE then overwrites the data set factor with the link.

To break a link and return to normal evaluation, click %2 |

Once all the links have been created or broken as you want, click OK to exit the
dialog.

See Also
¢ “Setting Up Data Sets” on page 10-5
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Assigning Columns of Data

To analyze imported data, you need to assign columns of data to input factors
in the CAGE data set.

Data can be imported into a data set from outside CAGE, for example from an
engine test cell. In many cases, this data contains a set of input points (or
operating points) and the values of important measurable variables at those
points. To compare data like this with models (and/or tables) in a CAGE data
set, you have to assign columns of the data to the corresponding input factors
in the data set.

To assign data:
1 Select Data —> Assign.

2 In the dialog box, highlight the column that you want to assign and the
variable that you want to assign it to.

3 Click (-:’/ to assign.

To unassign data:
1 Select Data —> Assign.

2 In the dialog box, highlight the variable that you want to unassign.
3 Click '-.§ to unassign.

Note Assigning data to a CAGE expression overwrites that expression in the
data set. This does not affect the expression in the other parts of the CAGE
project.
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Manipulating Models in Data Set View

A model in a data set can be treated as either an input or an output. This is

particularly useful when a model is used as an input to another model and you
want to view specific values of the input model. For example, linking a model
of MBT Spark to a Spark model allows the evaluation of a TQ model at MBT.

To change a model to an input:
1 Highlight the desired model in either the factor view or the table view.

2 Select Treat as Input from the right-click menu.

To revert a model to an output:
1 Highlight the desired model in either the factor view or the table view.

2 Select Treat as Output from the right-click menu.
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Filling Tables from Experimental Data

Any table in the project whose axes (normalizers) exist as factors in the data
set can be filled from imported experimental data.

CAGE extrapolates the values of the experimental data over the range of your
table. Then it fills the table by selecting the values of the extrapolation at your
breakpoints.

To fill the table with values based on the experimental data:
1 To view the Table Filler display, click ﬂ in the toolbar.

This display asks you to specify the table you want to fill and the factor you
want to use to fill it.

2 In the lower pane, select the table from the Table list. This is the table that
you want to fill.

3 Select the experimental data from the Factor list. This is the data that you
want to use to fill the table.

For example, see the following display.
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The upper pane displays the breakpoints of your table as crosses, and the
operating points where there is data as blue dots.

4 To view the table after it is filled, make sure the Show table history after
fill box at the bottom left is selected. This is selected by default.

Data sets always display the points in the experimental data, not the values
at the breakpoints.
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5 To fill the table, click Fill Table.

If the Show table history after fill box is selected, the History dialog box
opens, similar to the one shown.

.} History for New_2D_Table |
Wergion | Carrment / Actioh | Date and Time |
3 Walues filed from data zet meas_tq_data, factor lgmeas 13-Map-2002 17.28:35
2 Set up 13May-2002 17:35:53 Feset |
1 Created 13-Map-2002 17.25:09

4dd

Femove

Edit...

i

500.000 1000.000 1600.000 2000.000 2500.000 3000.000 3500000
0100 12.245 13471 14 637 15084 14 622 13.805 13.044
0.z200 23.802 25,336 26.940 27.322 25.900 24,344 23.697
0.300 35140 36.987 38.812 38.876 36.598 33.4349 3 .E11
0.400 46.028 48,217 a1.118 51817 45,4490 45317 40.168
0.500 A6.838 58411 B0.742 g2.257 62.138 £1.7749 G2.486
0.600 G5.694 £9.387 65.545 £9.367 63.788 71.364 65.274
0.700 78.018 79.2845 78.640 TE0145 75705 829149 85871
0.800 85.4a82 88,409 92,981 498,475 92.016 91.030 93.018
0.900 104147 106.258 110.804 114,302 112.183 107.478 107 431
1.000 121.640 123967 126.968 129,007 128.826 127,634 127,643

Cloze Help

6 Click Close to close the History dialog box and return you to the Table
Filler display.

7 To view the graph of your table, select Data —> Plot —> Surface.
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This display shows the table filled with the experimental points overlaid as
purple dots.

Creating Rules
You can ignore points in the data set when you fill your lookup table.

By defining a region to include or exclude such points, you create a rule for the
table filling.

For example, you might want to fill a lookup table that has a range of operating
points that is smaller than the range of the experimental data.

To ignore points in the data set:

1 Select Data —> Plot —> Data Set. This displays the view of where the
breakpoints lie in relation to the experimental data.

2 To define the region that you want to include, left-click and drag the plot.
For example, see the following display.

This region defines a rule in the Table filling rules pane.



Filling Tables from Experimental Data
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3 To fill the table based on an extrapolation over these data points only, click
Fill Table.

The display of the surface now shows the table filled only by reference to the
data points that are included in the range of the table.

You can now review your data set using the options in the View and Plot panes
of Data Sets.

You can add any number of rules to follow when filling tables. For example, you
might be aware that a particular test run included in the chosen area is not
good data. You can click and drag to enclose any chosen point, then right-click
that rule (in the Table filling rules pane) and select Exclude Points. You can
set any number of rules to make sure you fill the table by using just the points
you are interested in.

Right-Click Options

Right-clicking the Table filling rules pane gives you the following options:
¢ Enable Rule: Apply the rule to the data.

¢ Disable Rule: Do not apply the rule, but also do not delete it.

¢ Exclude Points: Do not include these points in table filling.

¢ Include Points: Include points in table filling.
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¢ Promote Rule: Change order of rules.

¢ Demote Rule: Change order of rules.

¢ Clear Rule: Delete this rule.

You can use these options to enable an iterative process. You can fine-tune the

selection of data points: try different selections of data to fill your tables, check
the results, then reuse the same rules for the same or different tables.
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11 cadibration Manager

The Calibration Manager dialog box enables you to manage the sizes, values,
and precision of all items that can be calibrated. You can set these properties
manually or from a calibration file.

This discussion on the Calibration Manager includes these sections:

¢ “Setting Up Tables” on page 11-3
¢ “Table Properties” on page 11-7
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Setting Up Tables

To set up tables in CAGE, you first open the Calibration Manager dialog box.
Do this by selecting Tools —> Calibration Manager or by clicking ﬁ in the
toolbar.

You can either set up your tables manually or from a calibration file. You can
also copy table data from other sources.

Setting Up Tables Manually
1 Select the normalizer or table to set up from the list on the left.

2 Enter the number of rows and columns in the edit boxes in the Manual
Setup pane and select initial values for each cell in the table.

Note When initializing tables for a feature calibration (comparing a model to
a strategy) you should think about your strategy. CAGE cannot fill those
tables if you try to divide by zero. Modifier tables should be initialized with a
value of 1 for all cells if they are multipliers, and a value of 0 if they are to be
added to other tables. See “How CAGE Fills Tables” on page 8-14 and
“Initializing Table Values” on page 8-13.

3 Check the display of your table, then click Close.

kanual Setup

I 0 Rows I g Columng I Walue Set lp |
Precizion: [EEE Double Precision Edit Precizian... |

Setting Up Tables Using an Existing Calibration File
1 Open the file by clicking &/

This opens the Import Calibration dialog box.
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114

2 Select the type of file you want to open (M or Mat file) or select Automatic.
Click OK to open the file browser.

3 Browse to the calibration file, select it and click Open.

Note tutorialcal.mat is an example calibration file in the mbctraining
folder.

4 Highlight both the table in the Contents of Calibration File pane and the
table in the Calibratable Blocks pane that you want to associate with it.

5 Associate these two files by clicking

To associate all the items listed in the Calibratable Blocks pane with items
having the same names listed in the Contents of Calibration File pane,
click Ao - |,

6 Check the display of your table, then click Close.



Sefting Up Tables

Select the axis
or table to be
calibrated.

Manually set  /
up the table or

normalizer.

-} Calibration Manager
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0.400 44 442 46 B245 45 481 49 444 47 848 43872 38724
0.500 a6.504 58,746 61.483 £3.292 62,770 f0.781 60.130
0.600 BY.8930 £9.7491 72162 73070 70.788 F3.6BE 48 481 |
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heck the display of your table.
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11-6

Note You can add additional file formats to configure CAGE to work with
your processes.

Contact The MathWorks for details about adding file formats at
www.mathworks.com/products/mbc/.

Finding Items in the Calibration File

In a large calibration file, you might want to search for an item by name. To
search the Contents of Calibration File pane:

1 Click the Contents of Calibration File list.
2 Type the first few letters of the item that you are searching for.
3 The cursor moves to the letters specified as you type.

Copying Table Data from Other Sources

You can paste table values from Excel, for example, by copying the array in
Excel and clicking Paste g :

1 Open the desired Excel file and copy the array that you want to import.

2 In the Calibration Manager dialog box, click Paste g .

You can also set up a table from a text file:
1 Click B in the toolbar.

2 Select the desired file, then click Open.

Note If the size of the table is different from the file that you are copying,
CAGE changes the size of the table in the session.
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Table Properties

Table Properties

Table properties allow you to edit the precision of selected tables and
normalizers according to the way tables are implemented in the electronic
control unit (ECU). The ECU designer chooses the type of precision for each
element to make best use of available memory or processor power.

To edit the precision of a table or normalizer:
1 Select Edit Precision in the Calibration Manager dialog box.

Alternatively, if you highlight a table in a feature calibration, display the
table properties by selecting Table —> Properties.

2 Decide whether you want the precision to be writable, then either select or
clear the Properties Read-only check box.

3 Decide the type of precision you require for the table:
= Floating Point (See “Floating-Point Precision” on page 11-7.)
= Polynomial Ratio, Fixed Point (See “Polynomial Ratio, Fixed Point” on
page 11-9.)
= Lookup Table, Fixed Point (See “Lookup Table, Fixed Point” on
page 11-11.)
The following sections describe these types of precision in detail.

Floating-Point Precision

The advantage of using floating-point precision is the large range of numbers
that you can use, but that makes the computation harder.
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+) Table Properties x|

Precision type | Floating Point j

[~ Properties Read-only

¢ |EEE Double precision
™ |EEE Single precision

™ Custom precision

Mantizza Bits: I 52
Expaonent Bits: I 11

Range:

Inf ko I Inf

ok | Cancel | Help

There are three types of floating-point precision that you can choose from:

¢ IEEE double precision (64 bit)
¢ IEEE single precision (32 bit)
¢ Custom precision

If you choose Custom precision, you must specify the following:

¢ Number of mantissa bits
¢ Number of exponent bits

¢ Range of values restricting the values in the table
When you are done, click OK.

See Also

¢ For more information on IEEE double precision in MATLAB®, see Moler, C.,
“Floating points,” The Mathworks Company Newsletter, 1996.
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Table Properties

Polynomial Ratio, Fixed Point

The advantage of using fixed-point precision is the reduction in computation
needed for such numbers. However, it restricts the numbers available to the
user.

For example, the polynomial ratio is of the form (see the ratio shown)

_ 50x+0

0 +255

<} Table Properties x|

Frecision type Palyromial A atio, Fized F'u:uinlj

[~ Properties Fead-only

a0
40
30
20
10
f+ BYTE
0 = WORD
0 . 50 " LONG
Mumerator Coefficients : ™~ CUSTOM

I 50 0 Number of Bits: I a

Denominator Coefficients

| 0 255 Fixed Point Position: |-|_

Range ﬁ EiQn,Ed 4
nsigne
I 1] to I 50
QK. | Cancel | Help |

To edit the polynomial ratio:

1 Select the Numerator Coefficients edit box and enter the coefficients. In
the preceding example, enter 50 0.

The number of coefficients determines the order of the polynomial, and the
coefficients are ordered from greatest to least.
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2 Select the Denominator Coefficients edit box and enter the coefficients. In
the preceding example, enter 0 255.

3 Determine the range of values that you want to have in the table. In the
preceding example, enter 0 50.

To edit the size of the precision, choose from

* Byte (8 bits)

®* Word (16 bits)
* Long (32 bits)
¢ Custom

Next, determine whether you want the numbers to be signed (negative and
positive) or unsigned (nonnegative).
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Lookup Table, Fixed Point

<) Table Properties ; x|

Precizian type ILDDkup Table, Fixed Paint j

[~ Properties Fead-only

G0
40
20
' BYTE
0le—e—m—m—m——— = WORD
u 50 ¢ LONG
Physical Data : ¢ CUSTOM

| 050 Murmber of Bits: | 3

Hardware Data

I 0 Fizxed Point Position: I 1

Bz {+ Signed
" Unzigned
I 0 to I a0
QK | Cancel | Help |

The advantage of using fixed-point precision is the reduction in computation
needed for such numbers. However, it restricts the numbers available to the
user.

For example, consider using a lookup table for the physical quantity spark
advance for maximum brake torque (MBT spark). Typically, the range of values
of MBT spark is 0 to 50 degrees. This is the physical data. The ECU can only
store bytes of information and you want to restrict the hardware store to a
range of 0 to 8, with at most one decimal place stored.

To adjust the fixed-point precision of the lookup table:

1 Select the Physical Data edit box and enter the range of the physical data.
In the preceding example, enter 0 50.

2 Select the Hardware Data and enter the range to store. In the preceding
example, enter 0 8.
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11-12

3 Determine the range of values that you want to have in the table. In the
preceding example, enter 0 50.

To edit the size of the precision, choose from
¢ Byte (8 bits)
* Word (16 bits)

* Long (32 bits)
¢ Custom

In the preceding example, the hardware is restricted to 8 bytes and to one
decimal place.

4 Choose whether you want the numbers to be signed (negative and positive)
or unsigned (nonnegative) by clicking the radio buttons.
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1 2 Surface Viewer

12-2

The Surface Viewer enables you to view the model or the feature as it varies
over the ranges of its variables. You can automatically step through values of
a variable, to make a movie of the behavior of the feature or model.

You can view the model or feature using a variety of plot types.

Note The Surface Viewer is only available when you are viewing models or
the feature node of a feature calibration.

This section includes the following topics:

® “Viewing a Model” on page 12-3

¢ “Setting Variable Ranges” on page 12-5

¢ “Displaying the Model or Feature” on page 12-7

¢ “Displaying Errors” on page 12-10

¢ “Making Movies” on page 12-12

¢ “Printing and Exporting the Display” on page 12-13



Viewing a Model

Viewing a Model

To access the surface viewer, select Tools —> Surface Viewer or click @ on the
toolbar.

As the surface viewer opens, select the correct model or feature from the
project, by highlighting it in the lower list.

These are the main steps to view the model or feature using the Surface
Viewer dialog box:

Select the range for the variables. (See “Setting Variable Ranges” on
page 12-5.)

Display the model or feature in the correct format. (See “Displaying the
Model or Feature” on page 12-7.)

For example, as you view a feature, you can view either the strategy or the
model associated with that feature, or both. Alternatively, you can display
the error between the model and the strategy.

Make the movie. (See “Making Movies” on page 12-12.)

This enables you to view the model or feature as it steps through several
values of a variable. For example, if you want to view a feature calibrated for
maximum brake torque (MBT) as it varies over exhaust gas recycling (EGR),
you can make a movie of the feature.

Print or export the display. (See “Printing and Exporting the Display” on
page 12-13.)

The following sections describe these steps in more detail.

Note You can use the surface viewer to display your model or feature without
making a movie.
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1. Variable ranges

2. The model in the feature
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Sefting Variable Ranges

Setting Variable Ranges

The Surface Viewer does not work over continuous ranges, only at discrete
points. You must specify, for the model or feature, the discrete points you want
to include in the display. You can display models or features over a range of
points.

There are three ways you can indicate the points to include in the display. You
can specify

¢ A single value

¢ Each discrete point at which you want to evaluate the model (or feature)

For example, if you want to display the variable x at 0, 1, 7, 30, and 50, enter
the following in the appropriate edit box:

017 3050

® The values, in the following manner:
minimum value:step increment:maximum value
For instance, if you want to display the variable x from 0 to 50 in increments
of 5, enter the following in the appropriate edit box:
0:5:50
When you alter the variables, you can select whether you want the display to
update automatically or not. You can toggle the automatic update on and off by

selecting View —> Automatic Evaluation. When you want to update the
display, select View —> Evaluate Now.
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Before you can make a movie, ensure that all the variable values are set up in
this manner. You need to specify ranges for at least three variables to make a
movie. See “Making Movies” on page 12-12.
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Displaying the Model or Feature

Displaying the Model or Feature

There are several aspects of the display to consider before making the movie.

® You can rotate the model by left-clicking and dragging.

¢ Right-clicking the model or feature display brings up a menu (see below).
This gives options on how to display the model or feature.

Display Type 13 v Surface

. ) ) Cankour
Display PE if available? Table
?
Colorbar For PE plats? stacked lines

v Model
Strategy
Maodel & Strateqy
Error Display
Display Errar »

¢ Use the right-click menu to display the model or feature as
= A surface

Mew_Feature_1 - Model

spark
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= Contour lines

Mesy_Festure_1 - Model

04 r T T
s L g

a7t ...... Fap e ..... ‘E‘:"D-

= A table

You can only display the model or feature as a table if no more than two
inputs are variables. For more information, see “Setting Variable Ranges”
on page 12-5.

Mevs_Feature_1 - Model

0.200 0.250 0.300 0.350
B100 -7E33 0 4E1Z 0 0724 3TN
-4100 5054 1373 3065 7983
0100 2708 1538 E456  11.773
3900 0534 4740 94453 15082

£.900 1.287 E.427 12041 17910
11.900 2935 8398 14236 20285 {

C

15500 4351 10053 16032 22118
19900 &535 11333 17430 23502
23900 E485 12417 18429 24.403

4| | r N
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Displaying the Model or Feature

= Stacked lines
You can swap the variable that is displayed on each axis by clicking g

Mew_Festure 1 - Model

o
=
=]
=

spark

Displaying Other Views

Note that if you are using the surface viewer to view a feature, you can use the
right-click menu to view the following:

® Model
® Strategy
® Model and strategy

Viewing More Than One Model or Feature

To view more than one model or feature, select View —> Multiple Display
Mode.

Note For information on the two different error displays available using the
right-click menu, see the next section, “Displaying Errors” on page 12-10.
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Displaying Errors

12-10

There are two different error displays available using the right-click menu:

¢ Error between the model and the feature (See “Feature Error Data”
following.)
¢ Predicted error of the model (See “Predicted Error Data” on page 12-10.)

Feature Error Data

When you are viewing a feature, this displays the error between the strategy
and the model.

To display the error, select Error from the right-click menu.

You can choose the style that you want to use to display the error. You can
choose from one of the following styles by selecting Display Error from the
right-click menu:

¢ Error. This is the difference between the feature and the model.

¢ Absolute Error. This is the absolute value of the error.

¢ Relative Error (%). This is the error as a percentage of the value of the
model.

¢ Absolute Relative Error (%). This is the absolute value of the relative error.

To view the error statistics, select View —> Error Statistics. This opens a
dialog box with a list of the summary statistics for that model or feature.

Predicted Error Data

If the model is imported from the Model Browser, it is possible to display the
predicted error (PE) data.

The PE is the absolute error between the model and the data used to construct
the model. The Model Browser compares the model and the original data, and
stores the error between the model and the original data as the PE of the
model.

Viewing the PE
Select Display PE from the right-click menu.



Displaying Errors

You can only view the PE if you are displaying one of the following:
® Surface

® Table

Surface Display of PE

® Where the error is greatest, the surface is red.
® Where the error is least, the surface is blue.

It is possible to see a scale for the PE by clicking PE Colorbar from the
right-click menu.

Table Display of PE
The table shows all points that are beyond the PE threshold as being purple.

Setting the PE Threshold
To set the threshold of the PE display:

¢ Select Display Options —> Set PE Threshold.
The Predicted Error Threshold dialog box appears.
¢ Select an appropriate value for the PE threshold and click OK.
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Making Movies

12-12

The movie option allows you to see an evaluation over two variables at
successive values of a third variable. For example, a model of torque might
have speed (N), load (L), and air-fuel ratio (A) as inputs.

Variable xRy T Make Maovie
M O Sl

L el Ol e FHeplay
4,13 frames) CoCE

The movie option allows you to view how the torque model behaves over the
ranges of speed and load for successive values of air-fuel ratio.

You can only access the movie controls when three variables have a range
defined (rather than a single value). You can view the model surface plotted
across the range of two variables, and define the third variable as “time” to see
the model surface change across the third variable’s range.

Controlling the Movie
You have to indicate which variable you want to display on which axis:

1 Select the variable you want to vary over time (T) by clicking the correct
variable in the T column.

In the preceding torque model example, you can see that A is selected to vary
over T.

2 Select the variable you want to display on the x and y axes.

In the preceding torque model example, you can see that N is selected for the
x axis and L is selected for the y axis.

3 Click Make Movie.

Once the movie is made, you can replay the movie by clicking Replay.



Printing and Exporting the Display

Printing and Exporting the Display
To print the display, select File —> Print.

You can export the display to a comma-separated variable file.

To export the display, select File —> Export to CSV, then select one of the
following options:

® Model to export the model
® Strategy to export the strategy

® Error to export the error between the feature and model
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Using the Manual Calibration View

Select this view by clicking the Manual Calibration button. It opens
automatically if you add a table using the File —> New menu.

hanal
Calibration

The Manual Calibration view lists all the tables and normalizers in the
current CAGE session.

Here you can add or delete tables and normalizers, and you can calibrate them
manually. Once you have added new tables here you can also fill them using
experimental data by going to the Data Sets view.

You can use the History display from here (and from any other table or
normalizer view in CAGE) to view and manage changes in your tables. You can
use the History display to reverse changes and revert to previous versions of
your tables.

See

¢ “Adding and Deleting Tables” on page 13-3
¢ “Filling Tables from Data Tutorial” on page 5-1
¢ “Using the History Display” on page 13-5



Adding and Deleting Tables

Adding and Deleting Tables

When you are calibrating a collection of tables using either Feature or
Tradeoff calibrations, you cannot easily add or delete tables without affecting
the entire calibration.

You might want to add a table (for example, to fill by reference to experimental
data). Or you might want to delete a table (for example, after adjusting a
strategy for a feature calibration).

To add or delete tables, you can first select the Manual Calibration view.
CAGE automatically switches to this view if you add a table using the File —>
New menu items.

The Manual Calibration view lists all the tables and normalizers in the
current CAGE session.

Adding Tables
To add a table to a session:
1 Decide whether you want to add a one- or a two-dimensional table.

For example if you want to add a modifier table to account for the variation
in exhaust gas recirculation, add a one-dimensional table (which has one
input). If, however, you want to add a table with speed and load as its
normalizer inputs, then add a two-dimensional table.

2 Select File -> New —> 1D Table or File -—> New —> 2D Table as appropriate.
This automatically switches you to the Manual Calibration view.

3 Select Tools —> Calibration Manager to determine the size of your new
table. For information, see “Setting Up Tables” on page 11-3.

You can manually calibrate by entering values in any table.
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Deleting Tables

To delete a table or a normalizer from a session:
1 Select Manual Calibration view.

2 Highlight the required table or normalizer.
3 Click X/,

Note When deleting items, you must delete from the highest level down. For
example, you cannot delete a table that is part of a feature; you must delete
the feature first.
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Using the History Display

The History display enables you to view the history of any table or normalizer
in a CAGE session.

The History display lets you

® Revert to previous versions of tables and normalizers (See “Resetting to
Previous Versions” on page 13-7.)

¢ Compare different versions of tables and normalizers (See “Comparing
Versions” on page 13-8.)

You can view the History display of a table or normalizer by selecting View —>
History.
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<) History for Norm_N x|
Wergion | Carnrment / Action | Date and Time |
5 Rezet to values at 12-Moy-20010 15:01:34 12-Mov-2007 15:04; 26
5 Optirnized 12-Now-2001 15:02:42 Fieset |
4 Set uging zhare ave curvature algorithm 12-Moy-2001 15:01:50
3 Breakpaintz linearly autospaced T12-Mov-2001 15:01:34 Add
2 Initialized 12-Mov-2007 15:00:52
1 Created 12-Mow-2001 15:00:07 e |
Edit comment |
Input Output
496,000 0.000
1360545 1.000
17240591 2.000

2089.636 3.000
2454182 4.000
2818727 5.000
3183.273 G.000
3547818 7.000
3912.364 2.000
4276909 9.000
4641.455 10.000
5006.000 11.000

Cloze

‘

The upper pane of the History display lists all the versions of the highlighted
object.

The lower pane displays the normalizer or table of the highlighted version.
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Resetting to Previous Versions
To reset the normalizer or table to a previous version:

1 Highlight the previous version that you want to revert to.

2 Click Reset.

Note Tables are independent of normalizers, so if you reset a table to a
previous version you must also reset the normalizers to that version (if they
have changed).

To remove previous versions of the object or comments:
1 Highlight the version that you want to remove.

2 Click Remove.

Adding and Editing Comments About Versions
To add comments:

1 Click Add.
2 In the dialog box enter your comment.

3 Click OK.

To edit comments:

1 Select the comment that you want to edit.
2 Click Edit comment.

3 In the dialog box, edit the comment.

4 Click OK.
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Comparing Versions

To compare two different versions of a normalizer or table, highlight the two
versions using Ctrl+click. Note the following:

® The lower pane shows the difference between the later and the earlier
versions.

e Cells that have no entries have no difference.

e Cells that have red entries have a lower value in the later version.

¢ Cells that have black entries have a higher value in the earlier version.

Comparison Table in the History Display

0.200

1465.000

1772.000

2153.000

2616.000

3117.000

3548.000

3963.000

0.259

0.323

-15.347

0.392

-15.947

0.462

-13.148

-3.1149

0.530

13.703

9.764

0.594

19.264

0.646

0.694

0.731

0.766

0.800
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